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                              BÀI 19: LẬP CÔNG THỨC ĐỂ TÍNH TOÁN

I. Mục tiêu

1. Kiến thức:
· Hiểu được khái niệm, vai trò của công thức trong Excel.

· Biết cách nhập công thức vào ô tính.
2. Kỹ năng:
· Nhập và sử dụng công thức trên trang tính.

3. Thái độ: Yêu thích môn học, nghiêm túc trong thực hành.
II. Chuẩn bị
1. Giáo viên: SGK nghề, giáo án.
2. Học sinh: SGK nghề, vở ghi.
III. Tiến trình bài giảng
1. Ổn định lớp

2. Kiểm tra bài cũ

3. Nội dung bài mới
	NỘI DUNG
	HOẠT ĐỘNG CỦA GV
	HOẠT ĐỘNG CỦA HS

	I. SỬ DỤNG CÔNG THỨC:

VD: Công thức
· Tính trung bình của 2 số 9 và 7, ta có công thức:

tb = (9 + 7)/2

· Tính diện tích của hình chữ nhật với chiều dài là d, chiều rộng là r:

S = d * r

Với d=10, r=5 thì s = 10*5=50. 
( Tính năng ưu việt của bảng tính là sử dụng công thức để tính toán.
· Bảng các kí hiệu được sử dụng làm các phép toán trong công thức:

· Các bước cần thực hiện khi nhập công thức vào ô tính:
( Chọn ô cần nhập công thức
( Gõ dấu =
( Nhập công thức
( Nhấn Enter


	Hoạt động 1: Tìm hiểu về sử dụng công thức trên bảng tính:

· Cho VD về 1 số công thức đơn giản trong toán học. 

· Giảng giải.

· Giới thiệu bảng các kí hiệu được sử dụng làm phép toán trong công thức (SGK).

· Y/c HS xem hình 4.11 và cho biết các bước cần thực hiện khi nhập công thức vào ô tính.

· Giảng giải.
· Vấn đáp: Làm thế nào để biết công thức trong ô tính? (Chọn ô tính và quan sát công thức được hiển thị trên thanh công thức).

· Đánh giá phần trả lời của HS.
	· Lắng nghe, quan sát

· Ghi bài

· Xem SGK và ghi bài

· Xem hình 4.11 SGK và nêu các bước cần thực hiện khi nhập công thức vào ô tính.

· Lắng nghe, ghi bài

· Trả lời: Chọn ô tính và quan sát công thức trên thanh công thức.

· Lắng nghe, ghi bài.

	II. SỬ DỤNG ĐỊA CHỈ Ô VÀ KHỐI TRONG CÔNG THỨC:

1. Địa chỉ của ô, hàng, cột và khối:

1. Khối: là một nhóm các ô liền nhau tạo thành hình chữ nhật. Khối có thể là 1 ô, 1 hàng, 1 cột, 1 phần của hàng hoặc 1 phần của cột.

· Địa chỉ của hàng, cột và khối được định nghĩa như sau: (SGK trang 123)

· Lưu ý: khi sử dụng địa chỉ của ô, khối trong công thức, nếu ta có thay đổi giá trị trong các ô, khối có tham gia trong công thức thì kết quả của công thức được cập nhật tự động.

1. Nhập địa chỉ vào công thức:

· Có 2 cách nhập:

C1: Nhập trực tiếp từ bàn phím.

C2: Nháy ô hoặc khối có địa chỉ cần nhập.

Lưu ý: Nếu ta nháy ô hoặc khối có địa chỉ cần nhập thì sẽ xuất hiện một đường viền chuyển động quanh ô, khối đó.
	Hoạt động 2: Tìm hiểu về sử dụng địa chỉ ô và khối trong công thức:
Vấn đáp: Em hãy nhắc lại khái niệm địa chỉ của 1 ô và cho VD?
- Diễn giảng: Khái niệm khối
- Y/c HS xem bảng trong SGK/123 + Giảng giải

- Cho VD minh hoạ.

- Giảng giải


	- Trả lời dựa vào kiến thức đã học.

- Lắng nghe

- Ghi bài

- Xem bảng trong SGK/123

- Lắng nghe

- Ghi bài

- Lắng nghe

- Ghi bài




IV. Tổng kết, đánh giá

· Em hãy cho biết các bước cần thực hiện khi nhập 1 công thức vào ô tính?

· Hãy nêu trình tự các bước nhập công thứ = C18*A2 vào ô B3.

· Cho biết khái niệm khối, cách nhận biết địa chỉ khối? Cho VD?
V. Dặn dò
· Xem trước bài 20

· Trả lời các câu hỏi cuối bài.

Tiết PPCT: 57, 58, 59
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BÀI 20: SỬ DỤNG HÀM
I. Mục tiêu

1. Kiến thức:
- 
Học sinh hiểu được khái niệm và công dụng của hàm trong bảng tính: Hàm là một công cụ được tạo sẵn, nhằm hỗ trợ việc tính toán được nhanh chóng hơn.

- Học sinh nắm vững được cách sử dụng của hàm: khi nào đùng  hàm SUM, SQRT…(lưu ý học sinh phải viết chính xác tên hàm và một số lỗi hay mắc phải của học sinh)

+ Hướng dẫn các em các cách để đưa ra các đáp số của một phép tính trong bảng tính (dùng ( trên công cụ và dùng ENTER)

+ Làm một vài ví dụ sử dụng 2 cách để đưa ra kết quả:

· AVERAGE(10,20,15)

· SQRT(144)

+ Phân biệt 2 cách dùng hàm:hàm trong FUNCTION và hàm tự gõ vào:

· Hàm trong FUNCTION thì chỉ cần dùng lệnh INSERT/FUNCTION chọn hàm cần dùng và OK.

· Hàm tự gõ vào phải chính xác.
2. Kỹ năng:
- Hiểu và nhớ khái niệm cũng như cách sử dụng của từng hàm.

- Phân biệt khi nào dùng các ký tự “, .’ ()…

3. Thái độ: Tích cực phát biểu, chuẩn bị bài chu đáo.

II. Chuẩn bị
1. Giáo viên: SGK nghề, giáo án.
2. Học sinh: SGK nghề, vở ghi.
III. Tiến trình bài giảng
1. Ổn định lớp

2. Kiểm tra bài cũ

3. Nội dung bài mới

	NỘI DUNG
	HOẠT ĐỘNG CỦA GV
	HOẠT ĐỘNG CỦA HS

	1.Khái niệm

  - Hàm là công thức được xây dựng sẵn, hàm giúp cho việc tính toán dễ dàng nhanh chóng,đơn giản hơn.
	Hoạt động 1: Giới thiệu về hàm trong bảng tính.
- Mục tiêu 2: Học sinh nắm được định nghĩa của hàm.
- Tiến hành: Liên hệ vào thực tế để các em hiểu được khái niệm và công dụng hàm:
Ví dụ: 

Để tính tổng số điểm 11 môn học của các em nếu tính bằng tay thì như thế nào?


	- Khi GV liên hệ HS đưa ra các câu hỏi thắc mắc: Tại sao phải đùng hàm,trong thực tế hàm có được dùng phổ biến không.

+ HS trả lời: Rất lâu



	
	- Vì thế ngày nay các chuyên gia xây dựng các hàm để hổ trợ việc tính toán được nhanh chóng hơn mà cụ thể trong trường hợp này là hàm trong bảng tính. Vậy hàm  có công dụng của hàm là gì?
-  Trong một cơ quan thì có sự tổ chức rất chặt chẽ mỗi người đảm nhiệm một nhiệm văn thư thì quả lý giấy tờ hồ sơ, kế toán thì ra các phiếu thu chi…trong EXELS cũng vậy các chuyên gia tin học đã xây dựng ra một thư viện các hàm mà mỗi hàm giữ một nhiệm vụ riêng :để tính tổng thì ta có hàm SUM, căn bậc hai thì có hàm SQRT…
- Người ta phân công công việc cụ thể nghư thế mục đích để làm gì? có phải để công việc được nhanh hơn không? Hàm trong bảng tính cũng vậy nó giúp ta tính toán nhanh chóng và chính xác hơn ví dụ: để tính điểm trung bình cho các em nếu làm bằng thủ công cộng từ từ thì rất lâu trong bảng tính có hàm hổ trợ việc tính điểm trung bình rát nhanh chỉ cần gõ đúng hàm là ta đã có kết quả chính xác và nhanh chóng.
Tiểu kết:  Công dụng của hàm.
	+ Giúp tính toán được nhanh chóng hơn.

+  Trả lời: nhằm giúp công việc được giải quyết một cách triệt để và nhânh chóng.

+ Lắng nghe và ghi bài.



	2. Cách sử dụng hàm
- Nhập đúng tên hàm vào ô của bảng tính.

- Cú pháp:

= Tên hàm(danh sách các biến)

- Phía trước tên hàm bắt  buộc phải có dấu”=”

- Tên hàm không phân biệt chữ hoa chữ hoa hay thường.

- Biến có hai loại:


+ Biến số như: =max(1,3,5)


+ Biến địa chỉ: min(B1:C2,D1:D6)

- Các biến hàm thì được đặt trong dấu ngoặc “()”, mỗi biến cách nhau dấu “,” hay dấu “.” tùy vào mỗi máy.

Ví dụ: Max(10,12,100,1)→100

 
	Hoạt động2: Dùng hàm trong bảng tính.

- Mục tiêu 3: Giúp HS nắm vững cách sử dụng hàm.

- Tiến hanh:Thực hành một vài ví dụ:

 + Nhập tên hàm không có khoảng trắng, một số hàm có nhiều biến SUM, MAX, MIN

· Sum(1,5,8,7,9,12) →32

· Min(1,5,12,42,78,0,90) →0

một số hàm không có biến như TODAY.

· Today()→20/09/2007

- Tiểu kết:Nắm được cú pháp của hàm.

- Vậy nếu một hàm ta gõ vào không có dấu “=” thì  có thực hiện được hay  không? Ví dụ:

SUM(2,8,9) →?


	- Quan sát Đặt câu hỏi và nêu những thắc mắc, ghi bài.

- Đưa ra một số ví dụ yêu cầu GV giải thích.

- Lên bảng giải các bài tập Gv ra

+ Trả lời: Không  và đưa ra cách giải quyết

	Một số hàm thông dụng:

- Hàm SUM(n1,n2…n): Dược dùng để tính tổng n biến trong ngoặc().

=Sum(12,15,2,B1:C2)→29

 12,15,2 các số,B1:C2 gọi là địa chỉ hoặc khối.

- Hàm AVERAGE():

- Hàm MIN():

- Hàm MAX():

- Hàm SQRT():

- Hàm TODAY():
	Hoạt động 4:Giới thiệu các hàm thông dụng.

- Mục tiêu: HS năm được công dụng của mỗi hàm và áp dụng làm các bài tập.

- Tiến hành:

+ Giới thiệu chức năng của từng hàm cụ thể, các đối số của mỗi hàm.

+ Cho ví dụ:hướng dẫn các em làm ví dụ. 

=sqrt(225) →15

=average(25,48,5,7,3) →17.6

+ Làm một số BT SGK

- Tiểu kết:nắm được một số hàm.

- Câu hỏi: Ta có thể đổi vị trí các đối số được không? Như vậy có ảnh hưởng đén kết quả không?
	- HS lắng nghe và ghi bài.

- Đặt câu hỏi 

- Giái các bài tập về hàm.

- Đưa ra các thác mắc sau khi đã giải các bài tập.

+ Một sồ hàm có thể đổi vị trí các đối số mà không thay đổi kết quả cồn một số hàm thì sẽ sai kết quả.


IV. Tổng kết, đánh giá

- Nhấn mạnh trọng tâm bài học, HS nắm vững những công dụng của mỗi hàm.

- Đánh giá tình hình lớp học tích cực hay không( những điểm cần phát huy và khắc phục).
V. Dặn dò

        - HS về học bài nắm được trọng tâm bài.


   
- Chuẩn bị bài cho tiết tới.
Tiết PPCT: 60, 61, 62
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                 BÀI 21: THAO TÁC VỚI DỮ  LIỆU TRÊN TRANG TÍNH

I. Mục tiêu

1. Kiến thức:
· Bieát caùc thao taùc chænh söûa, sao cheùp vaø di chuyeån döõ lieäu treân trang tính.

· Hieåu ñöôïc taàm quan troïng cuûa ñòa chæ töông ñoái vaø ñòa chæ tuyeät ñoái trong sao cheùp coâng thöùc.

2. Kỹ năng:
· Thöïc hieän caùc thao taùc chænh söûa döõ lieäu trong oâ tính.

· Thöïc hieän caùc thao taùc sao cheùp vaø di chuyeån döõ lieäu.


3. Thái độ:
· Nhaän thöùc ñöôïc vieäc thay ñoåi döõ lieäu trong oâ thì coù theå lieân quan ñeán caùc giaù trò cuûa nhöõng oâ coù lieân quan.

· Nhaän thöùc ñöôïc khi naøo duøng ñòa chæ töông ñoái, khi naøo duøng ñòa chæ tuyeät ñoái.

II. Chuẩn bị
1. Giáo viên: SGK nghề, giáo án.
2. Học sinh: SGK nghề, vở ghi.
III. Tiến trình bài giảng
1. Ổn định lớp

2. Kiểm tra bài cũ

3. Nội dung bài mới
	NỘI DUNG
	HOẠT ĐỘNG CỦA GV
	HOẠT ĐỘNG CỦA HS

	I. Xoùa, söûa noäi dung oâ tính:

-Xoùa döõ lieäu trong oâ hay khoái: Choïn oâ hay khoái vaø nhaán phím Delete

-Söûa ñoåi döõ lieäu trong oâ: Nhaùy ñuùp chuoät hoaëc aán F2 taïi oâ muoán söûa.

	Cho moät ví duï: minh hoïa goïi 1 hoïc sinh thöïc hieän veà xoùa vaø söûa döõ lieäu.

Ruùt keát cho hs ghi noäi dung
	Hoïc sinh thöïc hieän treân maùy cho caû lôùp xem.

Nhaéc laïi thao taùc vöøa laøm ñöôïc.

	II. Sao cheùp vaø di chuyeån

1. Sao cheùp hoaëc di chuyeån: Töông töï nhö Microsoft Word.

2. Sao cheùp hoaëc di chuyeån coâng thöùc:

a. Sao cheùp

OÂ chöùa coâng thöùc (hoaëc haøm) coù chöùa ñòa chæ caùc oâ hay vuøng lieân quan.

C1: choïn oâ caàn sao cheùp sao coâng thöùc thöïc hieän thao taùc Copy sao ñoù queùt khoái vuøng caàn cheùp ñeán vaø aán Enter

	Goïi 1 hs thöïc hieän döïa vaøo ví duï ñaõ chuaån bò.

Cho moät ví duï vieäc sao cheùp oâ coù coâng thöùc.

Yeâu caàu 1 hoïc sinh nhaän xeùt veà coâng thöùc cuûa oâ vöøa cheùp ñeán.

Höôùng daãn caùch sao cheùp thöù 2 vaø goïi 1 hs thöïc hieän laïi thao taùc gv vöøa laøm.


	Hs thao thao taùc treân maùy. 

(So saùnh vôùi Word)

Goïi moät hs thöïc hieän

Coâng thöùc coù theå thay ñoåi

Hs thöïc hieän laïi thao taùc gv vöøa laøm



	C2: di chuyeån chuoät ñeán goùc döôùi beân traùi cuûa oâ caàn sao cheùp ñeán khi chuoät coù hình daáu coäng(+) vaø Drag mouse theo höôùng muoán sao cheùp.

Chuù yù: khi sao cheùp oâ chöùa coâng thöùc thì khi ñeán oâ ñích thì coâng thöùc coù theå thay ñoåi.

b. Di chuyeån:

Khi di chuyeån thì coâng thöùc töø oâ naøy sang oâ khaùc baèng leänh Cut vaø Paste thì coâng thöùc seõ giöõ nguyeân khoâng thay ñoåi.
	Minh hoïa ví duï goïi moät hoïc sinh nhaän xeùt veà coâng thöùc trong oâ khi di chuyeån.
	Coâng thöùc khoâng thay ñoåi nhö sao cheùp.

	III. Ñòa chæ töông ñoái, ñòa chæ tuyeät ñoái vaø ñòa chæ hoån hôïp
1.Ñòa chæ töông ñoái: Laø ñòa chæ seõ bò thay ñoåi khi sao cheùp coâng thöùc sang vò trí khaùc.

Ñòa chæ töông ñoái coù daïng sau:

<Teân coät><Teân haøng>

Ví duï: A1, B2,…

2.Ñòa chæ tuyeät ñoái: Laø ñòa chæ khoâng thay ñoåi khi sao cheùp coâng thöùc sang vò trí khaùc.

Ñòa chæ tuyeät ñoái coù daïng sau:

<$Teân coät><$Teân haøng>

Ví duï; $A$1, $B$2,…

3.Ñòa chæ hoån hôïp: laø ñòa chæ coù theå laø coät tuyeät ñoái doøng töông ñoái hoaëc ngöôïc laïi.

Ñòa chæ hoån hôïp coù daïng sau:

<$Teân coät><Teân haøng> 

hoaëc <Teân coät><$Teân haøng>

Neáu laø coät tuyeät ñoái thì khi sao cheùp ñòa chæ coät seõ khoâng thay ñoåi, neáu laø doøng tuyeät ñoái thì doøng seõ khoâng thay ñoåi.
	Laáy ví duï minh hoïa ñeå thöïc hieän.

Thöïc hieän thao taùc Copy vaø goïi hs nhaän xeùt coâng thöùc cuûa oâ vöøa cheùp ñeán.

Giôùi thieäu veà daïng cuûa ñòa chæ töông ñoái.

+Laáy ví duï minh hoïa söï caàn thieát phaûi söû duïng ñòa chæ tuyeät ñoái trong coâng thöùc.

+Yeâu caàu 1 hs thöïc hieän thao taùc sao cheùp coâng thöùc.

Laáy ví duï minh hoïa töông töï nhö treân nhöng söï caàn thieát phaûi duøng ñòa chæ hoån hôïp.(ví duï veà phí phaân boå)

Giôùi thieäu caùch bieán ñoåi nhanh töø ñòa chæ töông ñoái sang ñòa chæ tuyeät ñoái vaø hoån hôïp.(F4)
	Hoïc sinh chuù yù 

Coâng thöùc coù söï thay ñoåi

Chuù yù vaø  ghi noäi dung baøi.

Yeâu caàu hoïc sinh thöïc hieän ban haønh coâng thöùc tính.=> Keát quaû ñuùng.

+Nhaän xeùt keát quaû thöïc teá=>Sai.(Kieåm tra laïi coâng thöùc oâ sai)

Töông töï phaàn treân


IV. Tổng kết, đánh giá

+ Thao taùc sao cheùp, di chuyeån

+ Söï caàn thieát phaûi duøng ñòa chæ tuyeät ñoái, ñòa chæ hoån hôïp, caùch vieát ñòa chæ

+ Phaùt phieáu thöïc haønh cho hoïc sinh.

V. Dặn dò


+ Xem trước nội dung bài 22.

Tiết PPCT: 63, 64, 65
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                 BÀI 22: NHẬP , TÌM VÀ THAY THẾ NHANH DỮ LIỆU


I. Mục tiêu

1. Kiến thức:

- Hiểu được bản chất, lợi ích của thao tác kéo thả nút điền và cách thực hiện;


- Biết cách sử dụng tính năng tìm và thay thế của Excel.
2. Kỹ năng:

- Điền nhanh dữ liệu bằng thao tác kéo thả nút điền;


 

- Sử dụng thành thạo tính năng tìm và thay thế của Excel.

3. Thái độ:


- Nghiêm túc, tập trung vào bài giảng.
II. Chuẩn bị
1. Giáo viên: SGK nghề, giáo án.
2. Học sinh: SGK nghề, vở ghi.
III. Tiến trình bài giảng
1. Ổn định lớp

2. Kiểm tra bài cũ

3. Nội dung bài mới
	NỘI DUNG
	HOẠT ĐỘNG CỦA GV
	HOẠT ĐỘNG CỦA HS

	1. Nút điền và thao tác với nút điền:

( Góc dưới bên phải của ô đang chọn gọi là nút điền.

 ( Chọn nút điền và kéo thả sang vị trí khác gọi là thao tác trên nút điền


	(Mời các em quan sát hình dạng chuột khi giáo viên thực hiện và trả lời.

(Khi nào trỏ chuột có hình +?

(Mời các em xem lại thao tác 1 lần nữa.

(Vậy dấu hình vuông góc dưới bên phải của ô đó gọi là gì?


	- Chú ý thao tác của giáo viên.

- Trả lời di chuyển chuột đến đường viền ô đang chọn.(Sai)

Lúc này hs trả lời đúng.

(Nút điền

	2. Sao chép dữ liệu bằng nút điền:

a) Sao chép công thức:

- Kéo thả nút điền từ một ô có công thức sang vị trí đích gọi là sao chép công thức.

b) Sao chép dữ liệu số:

- Nếu chọn một ô và kéo thả nút điền, dữ liệu trong ô đã chọn được  lặp lại vào các ô liền kề.

- Khi chọn khối gồm 2 ô và kéo thả nút điền, các số mới được điền vào các ô trống theo cấp số cộng với công sai là hiệu các số trong 2 ô.
c) Sao chép dữ liệu kí tự:

- Nếu chọn các ô liên tiếp có các dữ liệu kí tự và kéo thả nút điền, nội dung của các ô sẽ được sao chép lặp lại vào các ô liền kề, bắt đầu từ dữ liệu trong ô đầu tiên.


	Mời các em xem thao tác và trả lời câu hỏi sau:

(Ô vừa chép đến dữ liệu có giống với ô ban đầu không?

(Mời một hs kiểm tra lại công thức trong ô có đúng không và em có kết luận gì?

(Mời các em quan sát thao tác của thầy và cho biết đây là thao tác gì?

(Tiếp tục mời các em xem thao tác tiếp theo và cho biết thao tác này có gì khác.

(Giáo viên giới thiệu đây cũng là thao tác sao chép với cấp số cộng với công sai là ô thứ 2-ô thứ 1

(Tương tự thao tác trên và cho học sinh so sánh giữa 2 thao tác.
	(Không

(Đúng. Đây là việc sao chép công thức.

(Thao tác sao chép.

(Tương tự thao tác vừa rồi nhưng dữ liệu có sự thay đổi.

(Chú ý lắng nghe và ghi chép nội dung.

(Chú ý và nhận xét.

	3.Tìm kiếm và thay thế

- Để tìm, chọn lệnh Edit->Find…

- Để đồng thời tìm và thay thế, chọn lệnh Edit-> Replace… 

- Muốn có thêm các tùy chọn trong tìm, thay thế trên hộp thoại Find and Replace nhấp vào nút Option và chọn các gợi ý.
	(Các em đã học thao tác tìm kiếm trong Word rồi? Vậy liệu Excel có thao tác này không?

(Mời các em xem thao tác của thầy. Vậy để mở công cụ tìm kiếm có tương tự như Word không?

(Giáo viên giới thiệu thêm mục chọn Opition

· Within: phạm vi tìm

· Search: cột hoặc dòng sẽ tìm.

· Lookin: Dạng tìm kiếm

(Ngoài ra còn thêm một số chức năng tìm kiếm cao cấp về nhà tự tìm sách tham khảo thêm.
	(Theo em thì có thể có.

(Tương tự

(Chú ý lắng nghe và xem thao tác của giáo viên minh họa


IV. Tổng kết, đánh giá

· Kéo thả nút điền

· Tìm và thay thế dữ liệu.
V. Dặn dò


- Đọc trước bài 23.
Tiết PPCT: 66, 67, 68
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BÀI 23: TRÌNH BÀY TRANG TÍNH

 THAO TÁC VỚI HÀNG, CỘT VÀ ĐỊNH DẠNG DỮ LIỆU
I. Mục tiêu

1. Kiến thức:


- Biết được các khả năng điều chỉnh hàng, cột và định dạng dữ liệu trên trang tính;

 

- Biết các thao tác xoá và chèn hàng hoặc cột trên trang tính.
2. Kỹ năng:



- Thực hiện các thao tác điều chỉnh hàng và cột trên trang tính;




- Xoá và chèn hàng, cột trên trang tính;




- Thực hiện các thao tác định dạng và căn chuẩn dữ liệu. 

3. Thái độ:


- Nghiêm túc, tập trung vào bài giảng.
II. Chuẩn bị

1. Giáo viên: SGK nghề, giáo án.

2. Học sinh: SGK nghề, vở ghi.

III. Tiến trình bài giảng

1. Ổn định lớp

2. Kiểm tra bài cũ

3. Nội dung bài mới
	NỘI DUNG
	HOẠT ĐỘNG CỦA GV
	HOẠT ĐỘNG CỦA HS

	1. Thực hành chèn cột và hàng, điều chỉnh độ rộng cột

*.Mục tiêu : sử dụng chuột hơặc thanh công cụ để chèn cột và hàng và định  dạng nội dung  

* Tiến hành:

a) + Di chuột vào vào tên sau đó xóa tên và sửa thành họ và tên

+ chọn cột họ và tên sau đó nháy chuột phải chọn Insert\Entire column rồi gõ tên Quê quán
+ Tương tự chọn cột Quê quán(số báo danh) sau đó nháy chuột phải chọn Insert\Entire Column rồi gõ tên số báo danh(Mã ưu tiên)
+ Di chuột vào ô cuối cùng sau đó gõ vào Đánh giá 
b) chọn dòng 1 nháy chuột phải chọn Insert\Entire row 

Chọn dòng B2 sau đó chọn nút 
[image: image1.png]


  trên thanh công cụ hoặc Format\Cells\Alignment\Merge Cells

Sau đó gõ nội dung vào theo yêu cầu


	- Khởi động Excel và mở bảng tính Diem (đã được lưu ở bài 21) ta thực hiện như thế nào?1sau đó thực hiện các yêu cầu sau:

Thao tác mẫu cho hs quan sát các thao tác

a) Sửa nội dung ô B1 thành họ và tên. Chèn các cột Quê quán và Số báo danh và mã ưu tiên .Đồng thời thêm cột Đánh giá vào ô bên phải cột cuối cùng

b) chèn thêm 3 hàng trống vào đầu trang tính và nhập kết quả thi đại học năm học…vào ô b2. kết quả tương tự như hình 4.42 a sgk trang 162


	Start\Program\Microsoft Excel(hoặc nháy vào biểu tượng 
[image: image2.png]


 trên màn hình)

- Để mở thư mục chọn File\Open\ mở đường dẫn đến tập tin cần chọn sau đó chọn Open sau đó quansát các thao tácmẫu mà gv hướng dẫn rồi thao tác theo
a) di chuyển và sửa cột tên
 +chọn cột họ và tên (quê quán,số báo danh) Insert\Entire column rồi gõ tên Quê quán(số báo danh, Mã ưu tiên)
b) Insert\Entire row 



	c) Di chuột vào các cột hoặc dòng rồi kéo lên hoặc kéo xuống theo yêu cầu

d) Nháy chuột phải vào sheet 1 dưới đáy màn hình chọn Rename rồi gõ tên Diem thi sau đó File\Save as \gõ tên Diem thi
	c) điều chỉnh độ rộng các cột sao cho dữ liệu được hiển thị hết trong các ô và các cột có độ rộng hợp lí.(không quá rộng)

d) Nháy đúp trên nhãn của trang tính gõ Diem thi và nhấn phím Enter hay nháy chuột tại một ô trên trang tính.
	c) 
[image: image3.png]


 hoặc Format\Cells\Alignment\Merge Cells

d) Rename rồi gõ tên Diem thi sau đó File\Save as \gõ tên Diem thi

	2.Nội dung và căn chỉnh dứ liệu:Tiếp tục với trang tính Diem thi.

* Mục tiêu:định dạng dữ liệu trang tính với Font chữ, cở chữ, kiểu chữ, màu chữ và canh đều dữ liệu

* Các bước tiến hành 

a) di chuột đến ô F4 sửa và đổi tên thành Môn thi

b) Format\cells\font\chỉnh  theo ý thích

c) chọn hàng 4 và chọn nút 
[image: image4.png]



	a)  Sửa đổi nội dung ô F4 thành Môn thi.

b) Định dạng văn bản trong ô B2 thành phông chữ khác, kiểu chữ đậm, cỡ chữ lớn hơn và màu xanh, văn bản trong các ô hàng 4 thành kiểu chữ đậm, mầu nâu sẫm.

c) Căn giữa dữ liệu trong các ô trên hàng 4, trong các cột A, E, G, J. Cuối cùng lưu bảng tính.
	a) sửa ô F4

b) Format\cells\font

+  VNI-Book,VNI- times,Ali…

+ chọn màu nền nháy nút 
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 trên thanh công cụ và chọn màu theo yêu cầu

+ chọn màu chữ nháy nút 
[image: image6.png]



c) căn giửa sau đó lưu File\Save (Ctrl+S)

	3. Thực hành điều chỉnh hàng, cột, điều chỉnh phông chữ và căn chỉnh dữ liệu: 

a) Format\cells\font\chỉnh  theo ý thích
b)Để định dạng Format\Cells\Font

C) Format\Cells\Alignment

Có thể thực hiện bằng 2 cách 

=AVERAGE(F7:L7) hoặc

= (F7+ G7+ H7+ I7+ J7+ K7+ L7)/7
	Để mở tập tin ta làm như thế nào?1

Mở bảng tính So diem thực hiện các điều chỉnh và định dạng sau:

a) Nội dung các ô B1, B2, B3 và B4 có các kiểu chữ với cở chữ và màu sắc khác nhau.

b) Hàng 6 được định dạng để phân biệt với dữ liệu trên các hàng tiếp theo.

c) Các cột có kiểu dữ liệu kí tự hoặc số và nội dung ô được căn chỉnh thích hợp.

khối M7:M17 có công thức tính điểm trung bình
	File\Open (Ctrl+O)

Chỉ đường dẫnđến nơi chứa tệp

* có thể thực hiện trên thanh công cụ

-căn chỉnh dữ liệu treng cột sao cho đẹp



	4.Thực hành tạo và trình bày trang tính
 * Mục tiêu:

Điều chỉnh kiểu dự liệu, phông chữ, cở chữ và màu chữ.


	Tạo trang tính báo cáo tình hình biểu diễn của nhà hát trong 1 tháng với như hình 4.44 sgk trang 163 (trừ cột F và hàng cuối cùng) và thực hiện theo yêu cầu:

- Thực hiện  định dạng với kiểu dữ liệu thích hợp,phông chữ, cở chữ và màu sắc khác nhau  

- Cột F có các công thức tính tiền bán vé thu được với từng loại vé tương ứng(b5:d8)

- Hàng 24 cho biết số vé bán được trong tháng và số tiền tương ứng
	- Nghe giảng và thao tác

	5. Xóa hoặc chèn các ô hay khối
Để xoá các ô hay khối ta nháy chuột phải vào ô hay khối chọn Delete\xuất hiện hộp thọai Delelte

-Shift cells left: Dịch các ô cùng hàng sang trái chiếm chổ bị xoá 

Shift cells up: Dịch các ô cùng hàng lên trên chiếm chổ bị xoá

Entire row: Xóa tòan bộ hàng và các ô được chọn

Entire row: Xóa tòan bộ hàng và các ô được chọn

Để chèn các ô hay khối ta nháy chuột phải vào ô hay khối chọn Insert\xuất hiện hộp thọai Insert

Giống như hộp thoại Delete nhưng chỉ khác left(right) up(down)
	a) Mở bảng tính Diem thi và thực hiện các thao tác xóa ô, khối, chèn thêm khối trong vùng có dữ liệu

b) với trang tính hình 4.45c hãy cho biết nội dung trang tính thay đổi như thế nào 

+ Xoá 2 ô E8:E9 với tùy chọn Shift cells up 

+ Chọn 2 ô E8:E9 và thực hiẹn chèn ô với tùy chọn Shift cells Down

+ Xóa các hàng 8:9 ở cột E:F

c) đóng bảng tính nhưng không lưu
	Xoá  ô chèn thêm theo ý thích

- Dịch chuyển các ô từ dưới lên và thay thế ô vừa bị xóa

- Dịch chuyển xuống 2 ô

- Dịch chuyển các hàng ở duới lên trên

File\close(exit)


IV. Tổng kết, đánh giá


- Hệ thống lại các thao tác.
V. Dặn dò

- Học bài và soạn bài mới bài 24 trình bày trang tính: định dạng ô

Tiết PPCT: 69, 70, 71
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BÀI 24: TRÌNH BÀY TRANG TÍNH







   ĐỊNH DẠNG Ô
I. Mục tiêu

1. Kiến thức:
· Bieát caùc khaû naêng ñònh daïng oâ: keû ñöôøng bieân vaø toâ maøu neàn, goäp/taùch oâ.

2. Kỹ năng:
· Coù yù thöùc ñuøng, tìm hieåu ñònh daïng oâ khi trình baøy trang tính.


3. Thái độ:
· Keû ñöôøng bieân vaø toâ maøu neàn cho caùc oâ tính. Goäp/taùch caùc oâ trang tính

II. Chuẩn bị
1. Giáo viên: SGK nghề, giáo án.
2. Học sinh: SGK nghề, vở ghi.
III. Tiến trình bài giảng
1. Ổn định lớp

2. Kiểm tra bài cũ

3. Nội dung bài mới

	NỘI DUNG
	HOẠT ĐỘNG CỦA GV
	HOẠT ĐỘNG CỦA HS

	I.Kẻ đường biên và tô màu nền

1.Kẻ đường biên.

(giống phần Word)
	Giống như ở Word
	Ôn lại kiến thức ở phần Word

-Xem hình :4.46a

	2.Tô màu nền

(Giống phần Word)
	
	-Xem hình : 4.47a

	II.Gộp ô và tách ô gộp 

-Chọn các ô cần gộp

-Vào Format-Cell- Alignment

Đánh dấu vào ô Merge cell

Chọn OK
	Tương tự như phần Word
	Xem hình 4.48

	III.Sử dụng thanh công cụ định dạng.

Tương tự giống như Word.
	Có thể sử dụng các nút lệnh trên thanh công cụ định dạng để thực hiện nhanh một số thao tác định dạng.
	Xem hình 4.49

	IV.Thực hành.

1.Nội dung

-Bài 1

-Bài 2

-Bài 3

-Bài 4

2.Tiến trình thực hiện:

- Mở bảng tính mới hoặc bảng tính đã có.

-Định dạng: kẻ đường biên, tô màu nền và gộp/ tách ô.


	Có thể sử dụng các nút lệnh trên thanh công cụ định dạng để thực hiện nhanh một số thao tác định dạng.
	


IV. Tổng kết, đánh giá
1.Hãy nêu mục đích sử dụng đường biên và màu nền của các ô trên trang tính. Chúng có ảnh hưởng đến dữ liệu trên trang tính không?

2.Hãy nêu các thao tác cần thực hiện để kẻ đường biên và tô màu nền cho các ô tính.

3.Để gộp các ô tách ô đã được gộp ta sử dụng lệnh nào ? Hãy cho một ví dụ đơn giản về lợi ích của việc gộp ô 

4.Giả sử các ô A4 và A6 có dữ liệu tương ứng là 4 và 15 . Ô E6 chứa công thức =A6+5 . Sau đó các ô A4, A5 và A6 được gộp lại . Công thức trong ô E6 sẽ cho kết quả như thế nào?


(A) 4;                                                   (B) 15 (giá trị ban đầu của ô A6)


(C) Cảnh báo và cho kết quả là 5        (D) Thông báo lỗi.

Hãy chọn câu trả lời đúng . 

Tiết PPCT: 72, 73, 74
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                            BÀI 25: BỐ TRÍ DỮ LIỆU TRÊN TRANG TÍNH


I. Mục tiêu

1. Kiến thức:
· Hieåu muïc ñích vaø taàm quan troïng cuûa vieäc phaân tích yeâu caàu laäp trang tính

2. Kỹ năng:
· Bieát ñaët vaø traû lôøi caùc caâu hoûi phaân tích tröôùc khi laäp trang tính

· Laäp ñöôïc trang tính döïa treân caùc keát quaû phaân tích


3. Thái độ:

· Coù yù thöùc ñuøng, hieåu muïc ñích vaø taàm quan troïng cuûa vieäc phaân tích yeâu caàu laäp trang tính.

II. Chuẩn bị
1. Giáo viên: SGK nghề, giáo án.
2. Học sinh: SGK nghề, vở ghi.
III. Tiến trình bài giảng
1. Ổn định lớp

2. Kiểm tra bài cũ

3. Nội dung bài mới
	NỘI DUNG
	HOẠT ĐỘNG CỦA GV
	HOẠT ĐỘNG CỦA HS

	I. MOÄT SOÁ CAÂU HOÛI(15phuùt)
Xeùt ví duï trong saùch giaùo khoa trang 175

Moät ñaïi lyù baùn phaàn meàm (PM) chia caùc phaàn meàm laøm 3 loaïi: Heä ñieàu haønh, PM heä thoáng vaø phaàn meàm cô sôû döõ lieäu (PMSCDL). Ñaïi lyù ñöôïc höôûng hoa hoàng baèng 5,8 % doanh soá baùn ñöôïc. Giaù baùn töøng loaïi PM ñöôïc cho trong baûng sau:
Loaïi PM

Giaù ñôn vò

Heä ñieàu haønh

1500

PM heä thoáng

3000

PM CSDL

6000

a. Muïc tieâu: Laäp trang tính ñeå löu döõ lieäu vaø xöû lyù tính toaùn theo yeâu caàu baøi toaùn.

b. Döõ lieäu: Laø döõ lieäu caàn nhaäp vaøo trang tính ñeå thöïc hieän caùc pheùp tính trong tröôøng hôïp naøy laø ñôn giaù  baùn vaø soá löôïng baùn cuûa töøng PM.


	Hoaït ñoäng 1: Xeùt ví duï trong saùch giaùo khoa trang 175

a. Muïc tieâu:Bieát muïc tieâu , döõ lieäu, tính toaùn, vaø trình baøy trang tính

b. Tieán haønh:

Caâu hoûi 1: Theo caùc em trong baøi toaùn treân ñeå coù theå xöû lyù tính toaùn ta phaûi thöïc hieän coâng vieäc gì ñeå ñöa döõõ lieäu treân vaøo trang tính?
Nhö vaäy ta phaûi laäp trang tính phuø hôïp ñeå löu tröû döõ lieäu vaø thöïc hieän tính toaùn theo yeâu caàu


	- Traû lôøi

- Ñaùnh giaù ñuùng sai

Ghi baøi



	c. Tính toaùn:

Caùc coâng thöùc ñeå thöïc hieän tính toaùn theo yeâu caàu 

Tieàn baøn PM = Soá löôïng x ñôn giaù

Toång doanh thu = coäng taát caû giaù trò tieàn baùn

Hoa hoàng = 5.8 x toång doanh thu
d. Trình baøy trang tính:

Vôùi baøy toaùn naøy ta trình baøy trang tính nhö sau
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	Caâu hoûi 2:

Döõ lieäu trong trang tính naøy goàm caùc döõ lieäu gi?

Ñeå coù theå tính hoa hoàng cho Ñaïi lyù caàn phaûi coù döõ lieâu giaù baùn moãi loaïi phaàn meàm vaø soá löôïng PM baùn ñöôïc cho moãi loaïi

Caâu hoûi 3: Chuùng ta phaûi söû duïng coâng thöùc naøo ñeå tính toaùn?

Tieàn baøn PM = Soá löôïng x ñôn giaù

Toång doanh thu = coäng taát caû giaù trò tieàn baùn

Hoa hoàng = 5.8 x toång doanh thu

Caâu hoûi 4: Caùc haõy ñeà xuaát yù kieán ñeå laäp trang tính ñeå thöïc hieän baøi toaùn naày 

Nhö vaäy ta caàn coù caùc coät Loaïi PM, Giaù baùn, Thaønh tieàn


	- Traû lôøi

- Ñaùnh giaù ñuùng sai

- Ghi baøi

- Traû lôøi

- Ñaùnh giaù ñuùng sai

- Ghi baøi

- Traû lôøi

- Ñaùnh giaù ñuùng sai

- Ghi baøi

	II. VÍ DUÏ THÖÏC HAØNH (22 phuùt)

Baøi toaùn 2:

Ngoaøi caùc ñieàu kieän vaø yeâu caàu gioáng nhö baøi toaùn 1, ñaïi lyù baùn phaàn meàm coøn ñöôïc thöôûng moät soá ñieåm tuyø theo phaàn meàm baùn ñöôïc. Vôùi moãi phaàn meàm baùn ñöôoïc ñieåm thöôûng ñöôïc cho theo baûng sau:

Loaïi PM

Ñieåm thöôûng

Heä ñieàu haønh

1

PM heä thoáng

2

PM CSDL

4

Vôùi moãi ñieåm thöôûng ñaïi lyù ñöôïc nhaän soá tieàn laø 50 $. Haõy ñieàu chænh trang tính ñeå theo doõi doanh soá, tieàn hoa hoàng, vaø tieàn thöôûng, toång doanh thu (= tieàn hoa hoàng + tieàn thöôûng) cuûa ñaïi lyù


	Hoaït ñoäng 2: Xeùt ví duï baøi toaùn 2

a. Muïc tieâu: Boå sung döõ lieäu treân baûng tính ñaõ coù , tìm ra phöông caùch toái öu ñeå baûng tính töôøng minh

b. Tieán haønh:


	- Traû lôøi 

-  Ñaùnh giaù

- Ghi baøi



	a. Muïc Tieâu:

b. Döõ lieäu cho tröôùc:

c. Döõ lieäu nhaäp vaø thay ñoåi thöôøng xuyeân

d. Döõ lieäu caàn tính

e. Coâng thöùc

Doanh soá = Toång soá tieàn baùn töøng loaïi phaàn meàm;

Tieàn baùn töøng loaïi phaàn meàm = soá löôïng x giaù ñôn vò

Tieàn hoa hoàng = doanh soá x 5,8%

Ñieåm thöôûng cuûa töøng loaïi phaàn meàm = soá löôïng baùn x ñieåm

Toång soá ñieåm ñaït ñöôïc = toång soá ñieåm cho 3 loaïi PM

Tieàn thöôûng = toång soá ñieåm x 50

Toång doanh thu = tieàn hoa hoàng + tieàn thöôûng


	Caâu hoûi 1:

Chuùng ta caàn boå sung theâm coät vaø doøng döõ lieäu naøo treân trang tính theo yeâu caàu baøi toaùn 2

 Theâm coät döõ lieäu Ñieåm thöôûng, coät soá ñieåm thöôûng vaø doøng Tieàn thöôûng, doøng toång soá ñieåm, doøng toång doanh thu

Caâu hoûi 2: Döõ lieäu cho tröôùc goàm nhöõng döõ lieäu naøo?

Tæ leä hoa hoàng 5,8%, tieàn thöôûng cho moãi ñieåm laø 50$, giaù baùn vaø soá ñieåm thöôûng ñoái vôùi töøng loaïi phaàn meàm

Caâu hoûi 3: Döõ lieäu nhaäp vaø thay ñoåi thöôøng xuyeân laø döõ lieäu naøo?
Soá löôïng cuûa töøng loaïi phaàn meàm

Caâu hoûi 4: Döõ lieäu caàn tính goàm nhöõng döõ lieäu naøo?

Doanh soá, tieàn hoa hoàng, tieàn thöôûng, toång doanh thu, soá ñieåm ñaït ñöôïc ñoái vôùi moãi phaàn meàm vaø toång soá ñieåm ñaït ñöôïc
Caâu hoûi 5: Caùc coâng thöùc caàn tính toaùn:

Coâng thöùc tính Doanh soá?

Coâng thöùc tính Tieàn baùn töøng loaïi phaàn meàm? 

Coâng thöùc tính Tieàn hoa hoàng

Coâng thöùc tính Ñieåm thöôûng cuûa töøng loaïi phaàn meàm ?

Coâng thöùc tính Toång soá ñieåm ñaït ñöôïc ?

Coâng thöùc tính Tieàn thöôûng ?

Coâng thöùc tính Toång doanh thu ?


	- Traû lôøi 

-  Ñaùnh giaù

- Ghi baøi

- Traû lôøi 

-  Ñaùnh giaù

- Ghi baøi

- Traû lôøi 

-  Ñaùnh giaù

- Ghi baøi

- Traû lôøi 

-  Ñaùnh giaù

- Ghi baøi

- Traû lôøi 

-  Ñaùnh giaù

- Ghi baøi

Tham gia ñoùng goùp yù kieán



	f. Trình baøy


	Caâu hoûi 6: Theo caùc em trang tính ñöôïc trình baøy nhö theá naøo?


	Tham gia ñoùng goùp yù kieán

- Traû lôøi 

-  Ñaùnh giaù

- Traû lôøi 

-  Ñaùnh giaù

- Traû lôøi 

-  Ñaùnh giaù




IV. Tổng kết, đánh giá


- Nhaäp vaø trình baøy döõ lieäu theo caùc haøng, coät, baûng hôïp lyù vaø thuaän tieän cho vieäc ñieàn nhanh coâng thöùc


- Söû duïng ñuùng caùc coâng thöùc caàn thieát

V. Dặn dò
 
- Traû lôøi caùc caâu hoûi trong saùch giaùo khoa trang 179, 181.

Tiết PPCT: 75, 76, 77
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BÀI 26: SỬ DỤNG CÁC HÀM LOGIC
I. Mục tiêu

1. Kiến thức:
- Hiểu mục đích sử dụng và cách nhập một vài hàm logic phổ biến.

2. Kỹ năng:

- Thực hiện được các tính toán có điều kiện với các hàm lôgic.


3. Thái độ:

- Nghiêm túc, lắng nghe theo dõi bài giảng của giáo viên.
II. Chuẩn bị
1. Giáo viên: SGK nghề, giáo án.
2. Học sinh: SGK nghề, vở ghi.
III. Tiến trình bài giảng
1. Ổn định lớp

2. Kiểm tra bài cũ

3. Nội dung bài mới

	NỘI DUNG
	HOẠT ĐỘNG CỦA GV
	HOẠT ĐỘNG CỦA HS

	Ví dụ về các phép tính toán có điều kiện thường gặp trong cuộc sống hằng ngày.
	Hoạt động 1: Giới thiệu và giải thích 2 ví dụ trong SGK.

a.Mục tiêu:
Hiểu được sự cần thiết của việc tính toán có điều kiện.
b.Tiến hành:
Yêu cầu học sinh đọc và tìm hiểu các ví dụ, chỗ nào chưa hiểu sẽ giải thích.
	Lắng nghe và tìm hiểu hai ví dụ trong sách giáo khoa, chỗ nào chưa hiểu thì phát biểu thắc mắc.


	Cú pháp và chức năng của hàm IF.
IF(phép_so_sánh, giá_trị_khi_đúng,     giá_trị_khi_sai ).


	Hoạt động 2:Giới thiệu cú pháp hàm IF.

a.Mục tiêu:
Nắm vững cú pháp và chức năng cũng như cách áp dụng chúng vào thực tế.

b.Tiến hành:
- Cung cấp cú pháp hàm và giải thích ý nghĩa của từng đối số hàm.
- Giới thiệu ví dụ liên hệ (Ví dụ 3 SGK) và giải thích ví dụ.
	Lắng nghe và quan sát, sau đó tham gia  giải các ví dụ do giáo viên đặt ra.

	Sử dụng các hàm IF lồng nhau.

	Hoạt động 3:Giới thiệu cú pháp hàm IF lồng nhau.

a.Mục tiêu:

Nắm vững cú pháp và chức năng cũng như cách áp dụng chúng vào thực tế.

b.Tiến hành:

- Cung cấp cú pháp hàm và giải thích ý nghĩa của từng đối số hàm.

- Giới thiệu ví dụ liên hệ (Ví dụ 4 SGK) và giải thích ví dụ.
	Lắng nghe và quan sát, sau đó tham gia  giải các ví dụ do giáo viên đặt ra.

	Cú pháp và chức năng của hàm SUMIF.
SUMIF(cột_so_sánh,tiêu_chuẩn,cột_lấy_tổng).


	Hoạt động 4:Giới thiệu cú pháp hàm SUMIF lồng nhau.

a.Mục tiêu:

Nắm vững cú pháp và chức năng cũng như cách áp dụng chúng vào thực tế.

b.Tiến hành:

- Cung cấp cú pháp hàm và giải thích ý nghĩa của từng đối số hàm.

- Giới thiệu ví dụ liên hệ (Ví dụ 5 SGK) và giải thích ví dụ.
	Lắng nghe và quan sát, sau đó tham gia  giải các ví dụ do giáo viên đặt ra.


IV. Tổng kết, đánh giá


- Nắm vững cú pháp hàm IF,IF lồng nhau, SUMIF và cách áp dụng vào tình huống thực tế.
V. Dặn dò

- Xem lại nội dung bài và tự làm lại các ví dụ trong sách giáo khoa.


- Xem trước nội dung bài sắp tới.

Tiết PPCT: 78
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KIỂM TRA 1 TIẾT

Sử dụng phần mềm MS-EXCEL hãy thực hiện bảng tính sau:

BẢNG GHI ĐIỂM THI
	TT
	SBD
	Họ và tên
	Văn
	Toán
	Chuyên
	Diện Khuyến khích
	Điểm

Khuyến khích
	Tổng điểm
	Điểm Bình quân
	Kết quả

	1
	051501
	Nguyễn Thị Dung
	8.25
	8.25
	7.25
	3
	
	
	
	

	2
	051502
	Trần Hoàng Long
	1.50
	6.25
	8.00
	
	
	
	
	

	3
	051503
	Phạm Thị Ly Na
	4.50
	5.00
	6.50
	4
	
	
	
	

	4
	051504
	Trần Văn Nam
	7.25
	6.00
	4.50
	2
	
	
	
	

	5
	051505
	Trần Thị Tuyết
	6.50
	6.25
	7.25
	1
	
	
	
	


Tổng cộng danh sách này có 5 thí sinh dự thi.

I/ Yêu cầu về tính toán

1. Điểm khuyến khích:
- Bằng 2.0 nếu Diện khuyến khích bằng 1.

- Bằng 1.5 nếu Diện khuyến khích bằng 2.
- Bằng 1.0 nếu Diện khuyến khích bằng 3.
- Bằng 0.5 nếu Diện khuyến khích bằng 4.

- Các trường hợp khác bằng 0.0
2. Tổng điểm = điểm Văn + điểm Toán + điểm Chuyên x 2, làm tròn đến hai chữ số thập phân.

3. Điểm bình quân = (Tổng điểm + Điểm khuyến khích)/4, làm tròn đến hai chữ số thập phân.

4. Kết quả: 

- Đỗ: nếu điểm bình quân từ 6.0 trở lên, môn 1 và môn 2 không dưới 2.0 đông thời môn chuyên không dưới 6.0.

- Hỏng: tất cả các trường hợp còn lại.
II/ Yêu cầu về kỹ thuật

Thí sinh đặt tên cho file bài làm của mình là <Lớp>_<Tên học sinh> là số báo danh của thí sinh. Ví dụ: 11A11_Y Ánh.
Tiết PPCT: 79, 80
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BÀI 27: THỰC HÀNH

LẬP TRANG TÍNH VÀ SỬ DỤNG HÀM

I. Mục tiêu

1. Kiến thức:


-Hiểu mục đích sử dụng và cách nhập một vài hàm lôgic phổ biến.
2. Kỹ năng:


-Tạo trang tính với các công thức, định dạng theo đúng yêu cầu.

II. Chuẩn bị
1. Giáo viên: SGK nghề, giáo án.
2. Học sinh: SGK nghề, vở ghi.
III. Tiến trình bài giảng
1. Ổn định lớp

2. Kiểm tra bài cũ

3. Nội dung bài mới

	NỘI DUNG
	HOẠT ĐỘNG CỦA GV
	HOẠT ĐỘNG CỦA HS

	Bài tập 1.

Bài tập 2

Bài tập 3

-Yêu cầu :

Nội dung ô H1 là ngày báo cáo và được nhập tự động từ thời gian hệ thống .

Các ô trong khối C14:E17 là tổng giá trị, giá trị trung bình, giá trị lớn nhất và giá trị nhỏ nhất của các số liệu cho và được tính trong các cột tương ứng của khối C5:E11.

-Gợi ý :

Bài 1.Sử dụng hàm IF trong ô C2 để tính |A-B|.

Bài 2. Sử dung hàm TODAY trong ô L8, sử dụng các công thức thích hợp trong khối L19:L25, sử dụng công thức tính phần trăm trong ô L28 và hàm Sum trong ô L30.

Bài 3. Sử dụng hai hàm IF lồng nhau trong ô D5, chẳng hạn.

=IF(B5=$G$5,C5*$H$5,IF(B5=$G$6 , C5*$H$6,0)), công thức Thu XK=Giá trị XK- Thuế XK trong ô E5(=C5-D5), hàm Sum trong ô C17 và hàm Average trong ô C15, hàm Max trong ô C16, hàm Min trong ô C17 và thực hiện thao tác kéo thả nút điền. Sử dụng hàm Sumif trong ô H14


	Phân tích từng bài tập
	Đọc những bài tập trang 193 và 194, rút ra nhãng nhận xét và thực hiện cách làm.

	 (=Sumif(B$5:B$11, G5, C$5:C11)) và kéo thả nút điền xuống các ô H15:H16. Cuối cùng sử dụng hàm Sum trong ô H17.
	
	


IV. Tổng kết, đánh giá

V. Bài tập

	CAÙC HAØM THOÁNG KEÂ (Statistical functions)
	
	

	14
	28
	36
	d
	2
	
	

	b
	 
	43
	57
	85
	
	

	19
	35
	study
	compare
	13
	
	

	23
	56
	14
	10
	computer
	
	

	some
	49
	28
	53
	 
	
	

	65
	8
	command
	52
	24
	
	

	66
	 
	51
	38
	Learn
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	Giaù trò lôùn nhaát 
	 

	
	
	
	
	
	Giaù trò nhoû nhaát 
	 

	
	
	
	
	
	Giaù trò trung bình 
	 

	
	
	
	
	
	Toång caùc giaù trò 
	 

	
	
	
	
	
	Soá oâ chöùa giaù trò 
	 

	
	
	
	
	
	Soá oâ chöùa giaù trò chuoãi  
	 

	
	
	
	
	
	Soá oâ chöùa giaù trò >50
	 

	
	
	
	
	
	Soá oâ baét ñaàu baèng chöõ "com"
	 

	
	
	
	
	
	
	

	Duøng caùc haøm luaän lyù ñeå ñieàn vaøo caùc oâ troáng ?
	
	


	CAÙC HAØM XÖÛ LYÙ CHUOÃI (TEXT FUNTIONS)
	
	

	Maët haøng 
	Maõ HÑ 
	Maõ loaïi 
	STTHÑ
	Ñôn giaù 
	Soá löôïng 
	Giaûm giaù 
	Thaønh tieàn 
	

	Kaki 2
	K1252
	 
	 
	80000
	15
	 
	 
	

	Jean 1
	J2011
	 
	 
	200000
	24
	 
	 
	

	Jean 2
	J0982
	 
	 
	150000
	12
	 
	 
	

	Kaki 1
	K5801
	 
	 
	120000
	30
	 
	 
	

	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	Yeâu caàu: 
	
	
	
	
	
	
	
	

	1. Laäp coâng thöùc cho coät Maõ Loaïi, bieát raèng: Kyù töï cuoái cuøng cuûa Maõ HÑ laø Maõ Loaïi

	2. Laäp coâng thöùc cho coät STT HÑ, bieát raèng: 3 kyù töï giöõa cuûa Maõ HÑ laø STT cuûa hoaù ñôn.

	3. Tính coät giaûm giaù sao cho:
	 
	 
	 
	 
	 
	 

	 
	Neáu Maõ loaïi laø 1 thì Giaûm giaù = 30%*Ñôn giaù * Soá löôïng
	 

	 
	Neáu Maõ loaïi laø 2 thì Giaûm giaù = 50%*Ñôn giaù * Soá löôïng
	 

	4. Tính coät thaønh tieàn = Ñôn giaù * Soáù löôïng - Giaûm giaù
	 
	 
	 

	CAÙC HAØM DOØ TÌM (LOOKUP FUNCTIONS)

	Hoï vaø teân
	ÑTB
	Xeáp loaïi 
	Haïng

	Traàn Minh 
	5.9
	 
	 

	Nguyeãn Baûo 
	8.6
	 
	 

	Leâ Hoàng
	9.2
	 
	 

	Phaïm Tuaán 
	9.5
	 
	 

	Cao Bích
	3.5
	 
	 

	Lyù Tuaán
	6.4
	 
	 

	Phan Coâng
	8.6
	 
	 

	
	
	
	

	Yeâu caàu: 
	
	
	

	1. Laäp coâng thöùc ñieàn döõ lieäu cho coät xeáp loaïi

	2. Xeáp haïng cho caùc hoïc sinh theo thöù töï töø cao ñeán thaáp


	BAÛNG CHIEÁT TÍNH GIAÙ THAØNH 
	

	STT
	Teân maët haøng
	ÑVT
	ÑG Nhaäp 
	SL
	Phí VC
	Thaønh tieàn 
	ÑG Xuaát 
	

	1
	ÑÖÔØNG 
	KG
	7500
	150
	 
	 
	 
	

	2
	TRÖÙNG 
	CHUÏC 
	10000
	225
	 
	 
	 
	

	3
	BÔ 
	KG
	40000
	118
	 
	 
	 
	

	4
	SÖÕA 
	HOÄP 
	7800
	430
	 
	 
	 
	

	5
	MUOÁI 
	KG
	3500
	105
	 
	 
	 
	

	6
	GAÏO 
	KG
	6000
	530
	 
	 
	 
	

	7
	BOÄT 
	KG
	4300
	275
	 
	 
	 
	

	
	
	
	
	
	
	
	
	

	
	Yeâu caàu:
	
	
	
	
	
	
	

	
	1. Laäp coâng thöùc cho coät phí vaïn chuyeån (Phí VC), bieát raèng
	 
	 

	
	Phí VC = (ÑC Nhaäp *SL)*5%
	 
	 
	 
	 
	 

	
	2. Laäp coâng thöùc cho coät thaønh tieàn bieát:
	 
	 
	 
	 

	
	Thaønh tieàn = ÑG Nhaäp*SL+Phí VC
	 
	 
	 
	 

	
	3. Laäp coâng thöùc cho coät ÑG Xuaát
	 
	 
	 
	 
	 

	
	ÑG Xuaát = Thaønh tieàn + 2%Thaønh tieàn
	 
	 
	 
	 

	
	4. Ñònh daïng caùc oâ chöùa trò daïng soá: khoâng coù soá leû vaø coù daáu phaân caùch phaàn nghìn

	BAØI TAÄP VEÀ NGAØY THAÙNG
	
	

	Ngaøy 
	Thöù 
	Soá ngaøy trong thaùng 
	Naêm nhuaën hay khoâng nhuaën
	
	

	27/06/2006
	 
	 
	 
	
	

	
	
	
	
	
	

	Yeâu caàu:
	
	
	
	
	

	1. Haõy laäp coâng thöùc in ra thöù (tieáng Vieät) cuûa giaù trò ngaøy.
	 
	 

	2. Laäp coâng thöùc in ra soá ngaøy coù trong thaùng cuûa thaùng ôû oâ B21.
	 
	 

	3. Laäp coâng thöùc xaùc ñònh xem naêm cuûa ngaøy ôû oâ B21 coù phaûi laø naêm nhuaän?
	 

	4. Thöû goõ caùc giaù trò ngaøy khaùc nhau ôû oâ B21 vaø kieåm tra keát quaû hieän leân ôû caùc oâ coøn laïi


	
	BAÛNG THANH TOAÙN LÖÔNG

	
	STT
	Hoï loùt
	Löông
 ngaøy
	Soá ngaøy
coâng 
	Löông
 thaùng
	Chöùc
 vuï
	Thöôûng 
	Phuï caáp
chöùc vuï
	Thöïc
laõnh

	
	1
	Cao Vaên Coát
	50000
	26
	 
	GÑ
	 
	 
	 

	
	2
	Buøi Thò Beùo
	45000
	23
	 
	PGÑ
	 
	 
	 

	
	3
	Ñoã Vaên Ñaäu
	40000
	25
	 
	PGÑ
	 
	 
	 

	
	4
	Nguyeãn Vaên Cam
	37000
	26
	 
	TP
	 
	 
	 

	
	5
	Baïch Thò Taïng
	45000
	22
	 
	NV
	 
	 
	 

	
	6
	Tröông Vaên Sình
	40000
	20
	 
	NV
	 
	 
	 

	
	7
	Phaïm Thò Luaät
	37000
	18
	 
	NV
	 
	 
	 

	
	8
	Taï Vaên Toán
	50000
	25
	 
	TP
	 
	 
	 

	
	9
	Ñinh Thò Seùt
	50000
	26
	 
	NV
	 
	 
	 

	
	10
	Laâm Vaên Taëc
	37000
	17
	 
	NV
	 
	 
	 

	
	 
	 
	 
	 
	 
	Toång
coäng
	 
	 
	 

	
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	

	
	
	Löông cao nhaát
	 
	
	Soá ngöôøi laøm hôn 22 ngaøy
	 

	
	
	Löông trung bình
	 
	
	Soá ngöôøi coù löông hôn 1,000,000
	 

	
	
	Löông thaáp nhaát
	 
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	

	Yeâu caàu:
	
	
	
	
	
	
	
	
	

	1. Tính coät Löông Thaùng = Löông ngaøy*soá ngaøy coâng
	 
	 
	 
	 
	

	2. Laäp coâng thöùc cho coät thöôûng, vôùi möùc thöôûng ñöôïc aán ñònh nhö sau:
	 
	 
	

	 
	Neáu soá ngaøy coâng >=25: Thöôûng 20%* Löông Thaùng 
	 
	 
	 
	

	 
	Neáu soá ngaøy coâng >=22: Thöôûng 10%* Löông Thaùng 
	 
	 
	 
	

	 
	Neáu soá ngaøy coâng <22 :Khoâng Thöôûng
	 
	 
	 
	 
	

	HD: Duøng haøm if(soá ngaøy coâng >= 25,20%*Löông thaùng,if(…))
	 
	 
	 
	

	3.Laäp coâng thöùc cho coät phuï caáp chöùc vuï, bieát raèng:
	 
	 
	 
	 
	

	 
	Neáu chöùc vuï laø GÑ: 250,000   PGÑ:200,000  TP:180,000 NV: 150,000
	 
	

	4. Tính coät Thöïc Laõnh= Löông thaùng +Thöôûng + Phuï caáp chöùc vuï
	 
	 
	

	5. Laäp coâng thöùc laáy soá lieäu cho caùc oâ toång coäng, Löông cao nhaát, thaáp nhaát, trung bình
	

	6. Laäp coâng thöùc laáy soá lieäu cho caùc ngöôøi laøm hôn 22 ngaøy, soá ngöôøi löông hôn 1 trieäu.
	

	HD: Duøng haøm Countif
	 
	 
	 
	 
	 
	 
	

	7. Ñònh daïng caùc oâ thuoäc coät Thöïc laõnh sao cho:
	 
	 
	 
	 
	

	 
	Neáu Thöïc laõnh >= 1,000,000 thì in ra vôùi maøu ñoû
	 
	 
	 
	

	 
	Neáu 800,000 < Thöïc laõnh < 1,000,000 thì in ra vôùi maøu xanh Blue
	 
	

	 
	Neáu Thöïc laõnh < 800,000 thì in ra vôùi maøu tím(Magenta)
	 
	 
	

	HD: Duøng leänh Conditional Formatting
	 
	 
	 
	 
	 
	


	TÍNH LÖÔNG VAØ SOÁ NGAØY LAØM THEÂM
	
	

	
	Phoøng kinh doanh
	
	
	
	
	
	

	STT
	Hoï vaø teân 
	LNC
	Ngaøy Coâng
	Löông 
	Thöôûng 
	Thöïc Laõnh
	
	

	1
	Traàn Cao Kieán 
	45000
	25
	 
	 
	 
	
	

	2
	Nguyeãn Taâm Thaát 
	35000
	23
	 
	 
	 
	
	

	3
	Maïnh Thöôøng Nhaân
	45000
	22
	 
	 
	 
	
	

	4
	Vaên Só Dieän 
	40000
	25
	 
	 
	 
	
	

	
	
	
	
	
	
	
	
	

	
	Phoøng Keá Hoaïch 
	
	
	
	
	
	

	STT
	Hoï vaø teân 
	LNC
	Ngaøy Coâng
	Löông 
	Thöôûng 
	Thöïc Laõnh
	
	

	1
	Noâng Quoác Coâng
	45000
	20
	 
	 
	 
	
	

	2
	Voõ Vieät Nam
	35000
	24
	 
	 
	 
	
	

	3
	Leâ Nhaân Baûn
	40000
	18
	 
	 
	 
	
	

	4
	Phaïm Kim Coâ
	35000
	25
	 
	 
	 
	
	

	
	
	
	
	
	
	
	
	

	
	Baûng Toång Hôïp 
	
	
	
	Ngaøy coâng qui ñònh
	 
	22

	Phoøng
	Soá ngaøy
laøm theâm
	Thöôûng 
	Toång ngaøy coâng
laøm theâm
	Toång thöôûng 
	
	
	
	

	Keá Hoaïch
	 
	 
	 
	 
	
	
	
	

	Kinh Doanh
	 
	 
	 
	 
	
	
	
	

	
	
	
	
	
	
	
	
	

	Yeâu Caàu:
	 
	 
	 
	 
	 
	
	
	

	1. Ñaët teân vuøng cho oâ chöùa giaù trò ngaøy coâng qui ñònh laø NCQD
	 
	
	
	

	2. Laäp coâng thöùc tính löông cuûa caùc nhaân vieân thuoäc caùc phoøng, bieát raèng:
	 
	
	
	

	Löông=LCN*Ngaøycoâng, neáu Ngaøy coâng > NCQD thì LCB*NCQD
	 
	
	
	

	3. Laäp coâng thöùc tính tieàn thöôûng cho töøng nhaân vieân, bieát raèng:
	 
	
	
	

	Thöôûng (töøng ngöôøi) = möùc thöôûng cho 1 ngaøy vöôït *soá ngaøy coâng laøm vöôït cuûa ngöôøi ñoù
	
	
	

	4. Laäp coâng thöùc cho coät thöïc laõnh, bieát raèng
	 
	 
	 
	
	
	

	Thöïc laõnh= Löông + Thöôûng
	 
	 
	 
	 
	
	
	

	5. Laäp coâng thöùc tính soá lieäu cho baûng toång hôïp, bieát raèng
	 
	 
	
	
	

	Toång ngaøy coâng laøm theâm = Soá ngaøy coâng laøm vöôït NCQD cuûa 2 phoøng coäng laïi
	
	
	

	Thöôûng=(Toång thöôûng/Toång ngaøy coâng laøm theâm)*soá ngaøy vöôït(cuûa phoøng ñoù)
	
	
	

	
	
	GIAÛI PHÖÔNG TRÌNH BAÄC HAI ax2+bx+c=0

	
	a
	b
	c
	D
	x1
	x2
	

	
	4
	4
	-8
	144
	 
	 
	

	
	1
	-2
	1
	0
	 
	 
	

	
	2
	4
	60
	-464
	 
	 
	

	
	0
	4
	8
	16
	 
	 
	

	
	0
	0
	1
	0
	 
	 
	

	
	0
	0
	0
	0
	 
	 
	

	
	
	
	
	
	
	
	

	Yeâu caàu:
	 
	 
	 
	 
	 
	 

	1/ Soá lieïu cho caùc coät a, b, c ñöôïc nhaäp töø baøn phím
	 
	 

	2/ Laäp coâng thöùc tính Delta=b2-4ac döïa vaøo trò cuûa Delta laäp coâng thöùc tính nghieäm 

	cho 2 coät x1 vaø x2
	 
	 
	 
	 
	 
	 

	
	BAÛNG CHI TIEÁT THOÂNG TIN KHAÙCH HAØNG CUÛA 1  KHAÙCH SAÏN

	STT
	Hoï teân
	Maõ soá
	Ngaøy ñeán 
	Ngaøy ñi
	Tieàn
aên
	ÑGT
	ÑGN
	Toång coäng

	1
	Traàn Nam
	L1A-F3
	05/03/2001
	16/03/2001
	 
	 
	 
	 

	2
	Nguyeãn Thy
	L2A-F1
	06/03/2001
	20/03/2001
	 
	 
	 
	 

	3
	Nguyeãn An
	L1A-F2
	10/03/2001
	30/03/2001
	 
	 
	 
	 

	4
	Huyønh Baûo
	L2A-F1
	23/03/2001
	01/04/2001
	 
	 
	 
	 

	5
	Traàn Ñình
	L1B-F3
	17/03/2001
	30/04/2001
	 
	 
	 
	 

	6
	Phan Phuùc
	L2B-F2
	22/03/2001
	27/03/2001
	 
	 
	 
	 

	7
	Haø Baûo Ca
	L1A-F3
	30/03/2001
	21/04/2001
	 
	 
	 
	 

	8
	Phaïm Thaønh
	L2B-F3
	03/04/2001
	21/04/2001
	 
	 
	 
	 

	9
	Leâ Quoác
	L1B-F1
	05/04/2001
	12/05/2001
	 
	 
	 
	 

	10
	Buøi Theá Söï
	L1B-F2
	12/04/2001
	27/04/2001
	 
	 
	 
	 

	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	
	BIEÅU GIAÙ PHOØNG
	
	BIEÅU GIAÙ KHAÅU PHAÀN AÊN
	

	
	Loaïi phoøng
	ÑGT
	ÑGN
	
	Maõ phaàn aên
	F1
	F3
	

	
	L1A
	260000
	45000
	
	Ñôn giaù
	20000
	50000
	

	
	L1B
	250000
	40000
	
	
	
	
	

	
	L2A
	210000
	36000
	
	
	
	
	

	
	L2B
	190000
	30000
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	
	BAÛNG THOÁNG KEÂ
	
	
	
	
	
	

	
	Loaïi phoøng
	Doanh thu
	
	
	
	
	
	

	
	L1A
	0
	
	
	
	
	
	

	
	L2A
	0
	
	
	
	
	
	

	
	L1B
	0
	
	
	
	
	
	

	
	L2B
	0
	
	
	
	
	
	

	Yeâu caàu:
	 
	 
	 
	 
	 
	 
	

	1. Laäp coâng thöùc tính soá lieäu cho coät tieän aên, bieát : Tieàn aên = soá ngaøy ôû* ñôn giaù khaåu phaàn aên
	

	Bieát 2 kyù töï cuoái cuûa Maõ soá laø Maõ Phaàn aên
	 
	 
	 
	

	HD: Duøng haøm Hlookup, vôùi trò doø laø Maõ Phaàn Aên, baûng doø laø bieåu giaù khaåu phaàn aên
	

	2. Theâm coät Soá Tuaàn vaøo beân traùi coät ÑGT. Laäp coâng thöùc cho coät soá tuaàn, 
bieát soá tuaàn laø soá ngaøy ôû ñöôïc ñoåi ra tuaàn leã tuaàn leã (khoâng tính caùc ngaøy leû)
	

	HD: Duøng haøm Int hoaëc Trunc ñeå boû phaàn leû sau khi chia soá ngaøy ôû cho 7
	 
	

	3. Laäp coâng thöùc cho coät ÑGT (Ñôn Giaù Tuaàn)
	 
	 
	 
	

	HD: Duøng haøm Vlookup vôùi trò doø laø 3 kyù töï ñaàu beân traùi cuûa Maõ soá, Baûng doø laø Bieåu giaù phoøng
	

	4. Theâm coät soá ngaøy leû vaøo beân traùi coät ÑGN. Laäp coâng thöùc cho coät soá ngaøy leû bieát
	

	Soá ngaøy leû laø soá ngaøy ôû coøn laïi sau khi ñaõ ñoåi ra tuaàn
	 
	 
	 
	

	HD: Duøng haøm Mod laáy veà soá dö  cuûa pheùp chia soá ngaøy ôû cho 7
	 
	 
	

	5. Laäp coâng thöùc cho coät ÑGN (Ñôn Giaù Ngaøy)
	 
	 
	 
	

	6. Cheøn theâm coät tieàn phoøng vaøo beân traùi coät toång coäng
	 
	 
	 
	

	Tính Tieàn phoøng = ÑGT* Soá Tuaàn + ÑGN * Soá ngaøy leû
	 
	 
	 
	

	7. Theâm coät giaûm giaù vaøo beân traùi coät toång coäng. Tính Coät giaûm giaù bieát
	 
	

	Neáu soá ngaøy ôû töø 15 ngaøy trôû leân thì giaûm giaù 5% Tieàn phoøng
	 
	 
	

	8. Tính coät toång coäng baèng = Tieàn aên + Tieàn Phoøng - Giaûm Giaù
	 
	 
	

	9. Laäp coâng thöùc tính doanh thu theo töøng phoøng ôû Baûng Thoáng keâ
	 
	 
	

	HD: Duøng haøm sumif
	 
	 
	 
	 
	 
	


Tiết PPCT: 81, 82, 83



                              
      Ngày soạn: ….../…../20.....

Tuần:
29







      Ngày dạy: ….../…../20......

                 BÀI 28: DANH SÁCH DỮ LIỆU VÀ SẮP XẾP DỮ LIỆU


I. Mục tiêu

1. Kiến thức:


- Hiểu khái niệm danh sách dữ liệu và các thao tác sắp xếp dữ liệu;



- Hiểu thứ tự tự tạo.
2. Kỹ năng:


- Lập danh sách dữ liệu, sắp xếp các hàng trong danh sách dữ liệu.



- Tạo được thứ tự sắp xếp mới và thực hiện sắp xếp theo thứ tự mới.

II. Chuẩn bị
1. Giáo viên: SGK nghề, giáo án.
2. Học sinh: SGK nghề, vở ghi.
III. Tiến trình bài giảng
1. Ổn định lớp

2. Kiểm tra bài cũ

3. Nội dung bài mới

	NỘI DUNG
	HOẠT ĐỘNG CỦA GV
	HOẠT ĐỘNG CỦA HS

	I.Danh sách dữ liệu
Thông thường, danh sách dữ liệu được tổ chức theo một khối, trong đó các ô trên một cột thường có cùng kiểu dữ liệu (văn bản hoặc số). Hàng đầu tiên được gọi là tiêu đề và dữ liệu trong mỗi ô của hàng này được gọi là tiêu đề của cột tương ứng .Danh sách dữ liệu không nên có hàng hay cột trống.


	Một danh sách dữ liệu (hay bảng dữ liệu) trên trang tính là một dãy các hàng chứa các dữ liệu liên quan với nhau, chẳng hạn bảng điểm của một lớp hay danh sách số điện thoại của những người bạn … Chương trình bảng tính có nhiều tính năng giúp xử lý nhanh chóng các danh sách dữ liệu.
	Xem nhận xét ví dụ về danh sách hình 4.70

	II.Sắp xếp dữ liệu

- Xác định khối vùng cần SX có liên quan.

- Vào Data\Sort..

Hộp thoại xuất hiện để chọn:

+ Chọn tiêu đề cột cần SX theo

+ Chọn thứ tự tăng hay giảm.

+ Chọn có hàng tiêu đề hay không

+ Chọn <OK>
	Sắp xếp dữ liệu trong danh sách dữ liệu là thay đổi các hàng theo giá trị dữ liệu của các ô trong một hay nhiều cột với thứ tự tăng hay giảm dần. Thứ tự ngầm định của dữ liệu văn bản là thứ tự theo bảng chữ cái của tiếng Anh.
	Xem hình 4.71a rồi nhận xét cách sắp xếp 

	III.Tạo thứ tự sắp xếp

- Vào Tool-options..

- Hộp thoại xuất hiện:

+ Chọn trang Custom List

+ Chọn Thứ tự sx theo thứ tự tăng dần .

+ Nháy vào ADD

+ Nháy vào <OK>
	
	Xem hộp thoại trên hình 4.73

	IV.Thực hành
1.Nội dung thực hành

Bài 1

Bài 2

Bài 3

Bài 4

2.Tiến trình thực hiện

- Mở bảng tính mới.

- Sắp xếp dữ liệu theo yêu cầu.

- Tạo thứ tự sx và sx theo thứ tự tự tạo.

- Sắp xếp danh sách các cột trong danh sách dữ liệu.

- Tạo dữ liệu hỗ trợ tính toán.

- Lưu bảng tính và kết thúc.
	Phân tích từng bước của các bài tập thực hành.

*Đánh giá :

- Thực hiện thành thạo các thao tác sắp xếp dữ liệu theo một cột, nhiều cột và theo hàng.

- Biết định nghĩa các thứ tự tự tạo và thực hiện sắp xếp danh sách dữ liệu theo thứ tự tự tạo.

- Biết tạo dữ liệu hỗ trợ tính toán.
	Xem SGK trang 199 và 200 phân tích cho từng bài


IV. Câu hỏi

1. Danh sách là gì? Danh sách dữ liệu khác với các tập tập hợp dữ liệu khác trên trang tính ở những điểm nào?

2. Trên một trang tính có thể có bao nhiêu danh sách dữ liệu? Để có hiệu quả tốt nhất, trên một trang tính nên lập bao nhiêu danh sách dữ liệu.

3. Để sắp xếp danh sách dữ liệu ta có thể sử dụng lệnh gì của Excel.

Tiết PPCT: 84, 85, 86
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  BÀI 29: LỌC DỮ LIỆU TỪ DANH SÁCH DỮ LIỆU
I. Mục tiêu

1. Kiến thức:


- Hiểu khái niệm lọc dữ liệu từ danh sách dữ liệu;



- Biết các bước cần thực hiện để lọc dữ liệu từ một danh sách dữ liệu.
2. Kỹ năng:


- Lọc dữ liệu từ một danh sách dữ liệu;



- Sử dụng các tùy chọn (Top 10…), (Custom…) để lọc dữ liệu .

II. Chuẩn bị
1. Giáo viên: SGK nghề, giáo án.
2. Học sinh: SGK nghề, vở ghi.
III. Tiến trình bài giảng
1. Ổn định lớp

2. Kiểm tra bài cũ

3. Nội dung bài mới

	NỘI DUNG
	HOẠT ĐỘNG CỦA GV
	HOẠT ĐỘNG CỦA HS

	I. Lọc dữ liệu từ danh sách dữ liệu

1.Sử dụng AutoFiter để kết xuất dữ liệu
* Bước chuẩn bị, thực hiện các bước sau:

- Nháy chuột chọn 1 ô trong danh sách dữ liệu.

- Thực hiện lệnh

    Data-Filter-AutoFilter

* Chọn tiêu chuẩn lọc:

- Nháy mũi tên trên tiêu đề 

- Chọn giá trị làm tiêu chuẩn lọc.

* Sau khi có kết quả lọc ta có thể:

  - Thực hiện lệnh Data – Filter – Show All (Hiển thị tất cả) để hiển thị toàn bộ danh sách mà vẫn tiếp tục làm việc với Autofilter

- Thực hiện lại lệnh Data – Filter và bỏ đánh dấu AutoFilter để thoát khỏi chế độ kết xuất dữ liệu.
	Quá trình chọn và chỉ hiển thị các hàng thỏa mãn các tiêu chuẩn nhất định nào đó từ một danh sách dữ liệu được gọi là quá trình lọc hay kết xuất dữ liệu 

 * Sau khi có kết quả lọc theo giá trị trong một cột, có thể sử dụng các cột khác để tiếp tục chọn ra các hàng thỏa mãn thêm các tiêu chuẩn trên những cột đó.

 * Nếu chỉ cần kết xuất theo giá trị trên một cột thì chỉ cần chọn cột đó. Mũi tên bên phải tiêu đề cột chỉ xuất hiện trên cột được chọn.
	Xem hình 4.76a và 4.76b rồi nhận xét

	2.Sử dụng các tùy ý chọn (Top 10 ..) và (Custom)

a. Chọn top 10

- Chọn Top (lớn nhất) hoặc Bottom(nhỏ nhất)

- Chọn số giá trị lớn nhất (nhỏ nhất) cần lọc

- Chọn <OK>


	Trong mục trên ta thấy danh sách hiển thị mọi giá trị khác nhau của dữ liệu trong cột và chỉ có thể chọn một giá trị cụ thể làm tiêu chuẩn lọc.
	Xem hình 4.79



	b. Custom…

- Chọn quan hệ cho tiêu chuẩn thứ nhất.

- Chọn hoặc nhập giá trị cho quan hệ thứ nhất 

- Chọn And(và) hoặc Or(hoặc)

- Chọn quan hệ cho tiêu chuẩn thứ hai.

- Chọn hoặc nhập giá trị cho quan hệ thứ hai.

- Chọn OK
	
	Xem hình 4.80 và nhận xét

	II.Thực hành

1.Nội dung thực hành
- Bài 1

- Bài 2

- Bài 3.

2. Tiến trình thực hiện

- Mở bảng tính mới hoặc bảng tính đã có.

- Lọc dữ liệu từ đơn giản đến phức tạp.

- Lưu bảng tính và kết thúc Excel.
	*Đánh giá :

-Thực hiện thành thạo các thao tác lọc dữ liệu;

-Biết cho các tiêu chuẩn phức hợp khi lọc dữ liệu.
	* Thực hành trên máy


IV. Câu hỏi

1.  dữ liệu từ một danh sách dữ liệu là gì ? Hãy nêu một vài ví dụ thực tế.
2. Hãy nêu các bước cần thực hiện khi muốn lọc dữ liệu từ một danh sách dữ liệu.

3. Từ một danh sách dữ liệu có thể lọc các hàng nhận chính xác ba giá trị khác nhau trong một cột được không? Tại sao?

4. Cho biết vai trò của các kí tự thay thế * và ? trong các tiêu chuẩn lọc dữ liệu từ danh sách dữ liệu.

Tiết PPCT: 87, 88, 89
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                 BÀI 30: BIỂU DIỄN DỮ LIỆU BẰNG BIỂU ĐỒ
I. Mục tiêu

1. Kiến thức:
- Biết vai trò của biểu đồ trong biểu diễn dữ liệu, khả năng tạo biểu đồ từ bảng dữ liệu và các bước cần thực hiện để tạo biểu đồ.
2. Kỹ năng:


- Tạo biểu đồ từ danh sách dữ liệu;



- Thực hiện các thao tác sửa đổi biểu đồ

II. Chuẩn bị
1. Giáo viên: SGK nghề, giáo án.
2. Học sinh: SGK nghề, vở ghi.
III. Tiến trình bài giảng
1. Ổn định lớp

2. Kiểm tra bài cũ

3. Nội dung bài mới

	NỘI DUNG
	HOẠT ĐỘNG CỦA GV
	HOẠT ĐỘNG CỦA HS

	I. Biểu diễn dữ liệu bằng biểu đồ

Chương trình bảng tính cho phép tạo nhiều dạng biểu đồ khác nhau để biểu diễn dữ liệu. Trong chương trình bảng tính, biểu đồ được tạo từ các dữ liệu trên trang tính.

*Các nhóm biểu đồ :

- Biểu đồ cột.

- Biểu đồ đường  gấp khúc.

- Biểu đồ hình tròn.
	Các biểu đồ được gộp thành từng nhóm, mỗi nhóm có nhiều dạng . Mỗi dạng biểu đồ có các tùy chọn định dạng nhất định và có thể sửa đổi theo sở thích.
	

	II.Tạo biểu đồ

1.Bước thứ nhất – Chọn dạng biểu đồ.

- Chọn nhóm biểu đồ

- Chọn dạng biểu đồ trong nhóm.

- Nháy vào mục Next để sang bước 

2. Bước thứ hai – Xác định miền dữ liệu để vẽ biểu đồ.

- Kiểm tra miền dữ liệu và sửa đổi nếu cần 

- Chọn dữ liệu theo cột hay hàng.

- Nháy mục Next để sang bước 3.

3. Bước thứ ba – Chọn các tùy chọn của biểu đồ.

- Nhập tên đồ thị

- Nhập tên cho trục hoành

- Nhập tên cho trục tung.

- Nháy mục Next để sang bước 4.


	 Để  tạo một biểu đồ, thực hiện :

- Chọn một ô trong bảng tính dữ liệu cần vẽ biểu đồ.

- Nháy nút Chart Wizard trên thanh công cụ chuẩn.

Lần lượt sử dụng hộp thoại Chart Wizard được hiển thị sau đó, qua các bước chúng ta có thể cho các thông tin cần thiết để xây dựng biểu đồ.
* Trên các hộp thoại có vùng minh họa biểu đồ sẽ được tạo. Xem minh họa để biết các thông tin đưa vào có hợp lý không.

* Trên từng hộp thoại có thể nháy nút Back (quay lại) trở lại bước trước để thay đổi lại các thiết đặt trong bước đó.
	Xem hình 4.84a

Xem hình 4.84b

Xem hình 4.84c

Xem hình 4.84d

	4. Bước thứ tư – Chọn vị trí đặt biểu đồ.

- Chọn vị trí lưu biểu đồ.

- Nháy Finish để kết thúc
	
	

	II.Chỉnh sửa Biểu đồ 

   Xem SGK

III.Thực hành

1.Nội dung thực hành:

- Bài 1: Lập trang tính và tạo biểu đồ.

- Bài 2: Chỉnh sửa biểu đồ.

- Bài 3: Lập trang tính và tạo biểu đồ

- Bài 4: Tạo biểu đồ.

2.Tiến trình thực hiện:

- Lập trang tính hoặc mở bảng tính có dữ liệu làm cơ sở để tạo biểu đồ.

- Nháy chuột trong miền dữ liệu và nháy nút lệnh Chart Wizard trên thanh công cụ chuẩn.

- Thực hiện các bước tạo biểu đồ thông qua các hộp thoại.

- Sử dụng thanh công cụ Chart và bảng chọn Chart để chỉnh sửa, nếu cần thiết.

- Mở Word và sao chép biểu đồ tạo được vào Word.
	Hướng dẫn và làm mẫu.

*Đánh giá:

-Biết sử lý dữ liệu trước khi tạo biểu đồ .

-Thực hiện đúng các bước tạo biểu đồ từ bảng dữ liệu.

-Chỉnh sửa biểu đồ.

-Sao chép được biểu đồ từ trang tính vào trang văn bản Word.
	Xem bài tập thực hành trang 218 và trang 219


IV. Câu hỏi
1. Nêu các bước cần thực hiện để tạo biểu đồ từ một bảng dữ liệu.

2. Khi tạo biểu đồ, ngay từ bước 1 ta nháy Finish. Khi đó :


(A) Không có biểu đồ nào được tạo.


(B) Biểu đồ được tạo với các tham số ngầm định.

Hãy chọn phương án đúng.

3. Nêu các bước chung cần thực hiện để chỉnh sửa biểu đồ.

Tiết PPCT: 90, 91, 92



                              
      Ngày soạn: ….../…../20.....

Tuần: 32







      Ngày dạy: ….../…../20......



                 BÀI 31: THỰC HÀNH TỔNG HỢP

I. Mục tiêu



- Lập trang tính với công thức và định dạng thích hợp, sử dụng các hàm IF và Sumif;



- Lọc và sắp xếp dữ liệu;



- Tạo biểu đồ với dữ liệu tương ứng.

II. Chuẩn bị
1. Giáo viên: SGK nghề, giáo án.
2. Học sinh: SGK nghề, vở ghi.
III. Tiến trình bài giảng
1. Ổn định lớp

2. Kiểm tra bài cũ

3. Nội dung bài mới

	NỘI DUNG
	HOẠT ĐỘNG CỦA GV
	HOẠT ĐỘNG CỦA HS

	1.Nội dung thực hành

Bài 1: Lập trang tính .

Để lên kế hoạch và theo dõi những cách cần đọc trong một năm học, mỗi học sinh có thể lập danh sách trên trang tính bao gồm các thông tin sau về từng quyển sách : Tên sách, tác giả, loại sách, ghi chú (trong quá trình đọc), ngày (bắt đầu), đã đọc.

 Bài 2. Lập trang tính và tạo biểu đồ.

 Bài 3. Lập trang tính để tự động cập nhật kết quả.

 Bài 4.Mở bảng tính Nha hat

 Bài 5. Lập trang tính.

- Hãy phân tích yêu cầu để tính với các số liệu minh họa. Lưu bảng tính với tên kinh doanh.

- Sử dụng hàm thích hợp để tính với các số liệu minh họa . Lưu mã hàng và hình thức kinh doanh.


	Phân tích các bài tập 

Giả sử có trang tính ghi lại số sách giáo khoa và vở học một học sinh đã mua trong từng đợt như trong hình 4.95a

*Gợi ý:

-Bài 1: Một dạng bố trí có thể của trang tính như trên hình 4.98 SGK
	Đọc từng bài tập và phân tích.

Xem hình 4.95a

Xem hình 4.95b

Xem SGK trang 228 và 229



	2.Đánh giá:

-Sử dụng các hàm tích hợp, đúng cú pháp và kết quả chính xác.

-Sử dụng các địa chỉ (tương đối, tuyệt đối và hỗn hợp) tích hợp để có thể sao chép công thức bằng thao tác kéo thả nút điền.

-Các kết quả cần thiết được tự động cập nhật khi nhập dữ liệu mới.

-Tạo được các biểu đồ phù hợp yêu cầu.
	-Bài 3. Để sử dụng hàm sao cho các kết quả tính toán được tự động cập nhật, cần theo các bước sau: Sử dụng thêm một hàng trống cuối danh sách dữ liệu;

Bài 4: Sử dụng hàm Sumif trong các ô l12 và j12, với địa chỉ các khối D6:D18, E6:E18, F6:F18 . 


	


IV. Tổng kết, đánh giá
V. Dặn dò
Tiết PPCT: 93
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ÔN TẬP


I. Mục tiêu


- Kiến thức tổng hợp của chương trình bảng tính Excel.


II. Chuẩn bị
1. Giáo viên: SGK nghề, giáo án.
2. Học sinh: SGK nghề, vở ghi.
III. Tiến trình bài giảng
1. Ổn định lớp

2. Kiểm tra bài cũ

3. Nội dung ôn tập

- Các khái niệm cơ bản.


- Dữ liệu trên bảng tính


- Lập công thức để tính toán


- Sử dụng hàm


- Thao tác dữ liệu trên trang tính


- Nhập, tìm và thay thế nhanh dữ liệu


- Trình bày trang tính, thao tác với hàng, cột và định dạng dữ liệu


- Trình bày trang tính, định dạng ô


- Bố trí dữ liệu trên trang tính


- Sử dụng các hàm logic


- Danh sách dữ liệu và sắp xếp dữ liệu


- Lọc dữ liệu từ danh sách dữ liệu


- Biểu diễn dữ liệu bằng biểu đồ
IV. Tổng kết, đánh giá

V. Dặn dò
Tiết PPCT: 94, 95, 96
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BÀI 32: CÁC KIẾN THỨC CHUNG VỀ MẠNG CỤC BỘ
I. Mục tiêu

1. Kiến thức:
- Hiểu được khái niệm mạng máy tính nói chung và mạng cục bộ nói riêng

- Biết được các thiết bị cơ bản để kết nói các máy tính thành mạng cục bộ

- Hiểu khái niệm chia sẻ tài nguyên và quyền truy cập tài nguyên trên mạng cục bộ

2. Kỹ năng:
- Biết xem và truy cập các tài nguyên được chia sẻ trên mạng cục bộ

- Biết chia sẻ thư mục, ổ đĩa và máy in để dùng chung trên mạng cục bộ

- Biết sử dụng máy in mạng.

3. Thái độ:
- Học sinh cần nhận thức được ưu việt khi làm việc trong mạng cục bộ, rèn luyện phong cách làm việc cộng tác trên mạng một cách khoa học, có ý thức bảo mật và bảo vệ an toàn dữ liệu.

II. Chuẩn bị
1. Giáo viên: SGK nghề, giáo án.
2. Học sinh: SGK nghề, vở ghi.
III. Tiến trình bài giảng
1. Ổn định lớp

2. Kiểm tra bài cũ

3. Nội dung bài mới

	NỘI DUNG
	HOẠT ĐỘNG CỦA GV
	HOẠT ĐỘNG CỦA HS

	I. MỘT SỐ KHÁI NIỆM CƠ SỞ

1. Mạng máy tính

- Mạng máy tính là hệ thống các máy tính được kết nối với nhau với mục đích trao đổi thông tin giữa các máy

- Khi các máy tính được kết nối lại, ta có thể :

+ Cho phép người sử dụng dùng chung tài nguyên phần cứng, phần mềm và dữ liệu

+ Truyền dữ liệu nhanh chóng giữa các máy tính trên những khoảng cách xa

+ Giao dịch bằng thư điện tử, hoạt động kinh doanh trên mạng

+ Nhiều kho thông tin, csdl được tổ chức trên mạng, trở thành tài sản chung 

- Các loại mạng :

+ Mạng cục bộ

+ Mạng diện rộng

+ Mạng toàn cầu


	Hoạt động 1 : Tìm hiểu khái niệm mạng, phân loại mạng

a. Mục tiêu 

- Mạng là gì ?

- Các loại mạng

- Các thiết bị

b. Tiến trình

Hỏi : các phòng ban nào của trường lắp máy vi tính

Hỏi : chỗ nào có máy in

Hỏi : khi Cô Thư viện cần in văn bản thì cô phải làm gì

Hỏi : dữ liệu trên đĩa cô mang xuống còn in được không ?

Diễn giảng lợi ích của kết nối các máy tính lại => mạng máy tính

Thế nào gọi là mạng cục bộ ?

Nối kết các máy tính như thế nào ?

Quan sát mạng trong tranh vẽ, liệt kê các thiết bị mạng


	Trả lời : thư viện, BGH, đoàn thanh niên, . . 

Trả lời : Giáo vụ, Kế toán

Trả lời : Cô thư viên phải chép đĩa mang xuống in

Trả lời : có thể không in được vì đĩa hư, kg tương thích, . . .

Trả lời : đọc khái niệm trong sách giáo khoa

Trả lời dựa trên SGK

Lắng nghe, ghi bài

Lắng nghe, suy nghỉ & ghi bài
Liên kết các máy tính trong phạm vi gần

bằng dây cáp và các thiết bị mạng

Cáp, Hub, . . 



	2. Mạng cục bộ

- MCB là mạng liên kết các máy tính trong phạm vi nhất định

- Thường sử dụng dây cáp mạng để nối kết các máy tính và các thiết bị khác

3. Các thiết bị kết nối trong mạng cục bộ

- Cáp mạng

+ Cáp đồng trục

+ Cáp xoắn

+ Cáp quang

- Vỉ mạng

+ Chuẩn bị dữ liệu từ máy tính để truyền sang dây cáp mạng

+ Gởi dữ liệu tới máy khác

+ Kiểm soát dòng dữ liệu giữa máy tính và hệ thống dây cáp

+ Nhận dữ liệu . . 

- Hub, Switch
	Quan sát mạng trong tranh vẽ, liệt kê các thiết bị mạng

Giáo viên lần lượt giới thiệu các thiết bị đã chuẩn bị sẵn cho học sinh xem và nêu vai trò của từng loại thiết bị

c. Tiểu kết 

- Mạng

- Phân loại

- Các thiết bị
	Quan sát, lắng nghe, suy nghỉ và ghi chép

	II. LÀM VIệC TRONG MẠNG CỤC Bộ

1. Thế nào gọi là chia sẻ ?

- Chia sẻ là cho phép người nào đó trên mạng sử dụng chung các tài nguyên hiện có của mình (máy in, tập tin, máy quét, . . .)

- Người sử dụng muốn được dùng chung tài nguyên phải có quyền truy cập vào.

2. Quyền truy cập ?

- Quyền truy cập quyết định việc người sử dụng có được phép truy cập vào tài nguyên hay không, cũng như quyết định mức độ của việc truy cập đó.

- Khi quyết định đưa một tài nguyên nào đó ra để dùng chung, ta phải quan tâm tới hai việc :

+ Chia sẻ tài nguyên đó

+ Đặt quyền truy cập cho những người dùng đối với tài nguyên được chia sẻ

Chia sẻ máy in
	Hoạt động 2 : Giao tiếp trên mạng

a. Mục tiêu 

- Chia sẻ ~ làm việc nhóm

- Quyền truy cập

- Cho ~ nhận, cộng tác

b. Tiến trình

Giảng giải : khi bạn quên đem sách, bạn cho bạn xem cùng quyển sách => chia sẻ, cùng sử dụng

Vậy : chia sẻ # cho ?

Diễn giảng về chia sẻ trên mạng máy tính => nguyên lý : cho và nhận

Hỏi :  Khi đem đồ ra cho bạn dùng, bạn quan tâm điều gì ?

Diễn giảng về quyền hạn

Diễn giảng
	Lắng ghe & suy nghỉ

Trả lời : 

+ cho thì mất luôn

+ chia sẻ thì còn quyền sở hữu

Lắng nghe, ghi bài

Trả lời bạn có làm hư hỏng đồ mình không ?

Lắng nghe, ghi bài

Lắng nghe


IV. Tổng kết, đánh giá

- Nắm vững các khái niệm mạng máy tính, mạng cục bộ

- Biết và phân biệt một số thiết bị cơ bản dùng để lắp đặt một mạng cục bộ

- Hiểu khái niệm chia sẻ, quyền truy cập

V. Dặn dò
     - Làm các bài tập SGK trang 237

Tiết PPCT: 97, 98, 99
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BÀI 33: SỬ DỤNG MẠNG CỤC BỘ
I. Mục tiêu

1. Kiến thức:
- Ôn lại khái niệm và kiến thức cho mạng cục bộ.

2. Kỹ năng:
- Chia sẻ tài nguyên (tệ, thư mục, máy in)

- Sử dụng tài nguyên được chia sẻ trên mạng

- Làm việc được trong môi trường mạng cục bộ.
II. Chuẩn bị
1. Giáo viên: SGK nghề, giáo án.
2. Học sinh: SGK nghề, vở ghi.
III. Tiến trình bài giảng
1. Ổn định lớp

2. Kiểm tra bài cũ

3. Nội dung bài mới

	NỘI DUNG
	HOẠT ĐỘNG CỦA GV
	HOẠT ĐỘNG CỦA HS

	I. Xem các tài nguyên được chia sẻ trên mạng

-Nháy chuột phải vào biểu tượng My NetWork Places trên màn hình làm việc và chọn Explore

- Chọn Entire Netưork -> Microsoft Windows Network
	Hoạt động 1 : Làm việc nhóm

a.Mục tiêu

Làm việc theo nhóm

b.Tiến trình

Diễn giảng : muốn biết được hiện có bao nhiêu máy tính kết nối mạng ta làm như sau ?

Thao tác mẫu cho học sinh làm theo
	Lắng nghe, suy nghĩ

Lắng nghe, quan sát, ghi bài, thực hiện lại



	II. Chia sẻ thư mục

Dấu hiệu chia sẻ tài nguyên trong máy tính như thế nào ?

Biểu tượng hình bàn tay dưới các thiết bị, tập tin, thư mục 
[image: image8.png]




	Hoạt động 2 : Chia sẻ
a. Mục tiêu

- Dấu hiện ‘chia sẻ’
- Chia sẻ thư mục

b.Tiến trình

Hỏi : chúng ta vào mạng để làm gì ?

Diễn giảng : mỗi máy mỗi người sử dụng khác nhau, có những thông tin chúng ta cho người khác dung và có những thông tin chúng ta không cho người khác dùng ? 

Khi dùng các máy dùng chung, ta cần biết rằng máy chia sẻ cho người khác những gì ?

thể hiện biểu tượng chia sẻ trong máy

	Trả lời : để trao đổi thông tin . . . . 

Lắng nghe, suy nghĩ

Lắng nghe, quan sát, ghi bài



	1. Các bước tiến hành

a) Mô hình ngang hàng

- Vào File -> Properties và chọn trang Sharing hoặc chọn Sharing and Security từ bảng chọn tắt khi nháy chuột phải

- Đánh dấu vào lựa chọn Share this folder on the network

- Nháy Ok

b) Mô hình khách chủ

- Vào File -> Properties và chọn trang Sharing hoặc chọn Sharing and Security từ bảng chọn tắt khi nháy chuột phải

- Đánh dấu vào lựa chọn Share this folder và nhập các thông tin

- Nháy Ok

Truy cập thư mục chia sẻ
	Hỏi : máy các em chia sẻ những gì cho bạn ?

Hỏi : máy tính do chúng ta sở hữu-sử dụng, làm thế nào chia sẻ thông tin cho người khác

thể hiện thao tác cho học sinh xem
Diễn giảng các thông số cho học sinh nghe

Yêu cầu học sinh vào máy của ban xem sự thay đổi
	Quan sát trong máy, từng nhóm trả lời

Mô tả các thao tác trong sách giáo khoa

Lắng nghe, quan sát, ghi bài, lặp lại thao tác

Thư mục chia sẻ xuất hiện trong nguồn

	III. Sử dụng máy in trong mạng

1. Chia sẻ máy in

Cách 1. 

- Bấm vào Start -> Setting -> Printers and Faxes 

- Bấm chuột phải vào máy in cần chia sẻ chọn Sharing-> Share this printer -> OK

Cách 2.

- Bấm vào Start -> Setting -> Printers and Faxes 

- Chọn máy in File->Sharing-> Share this printer -> OK

Sau khi được chia sẻ, bên dưới biểu tượng máy in xuất hiện hình bàn tay thể hiện rằng máy in đã được chia sẻ

2. Kết nối tới máy in trong mạng

- Bấm vào Start -> Setting -> Printers and Faxes 

- Chọn Add a printer rồi tuân theo các chỉ dẫn để đưa các thông số về máy in vào

- Bấm OK
	Hoạt động 3 : In
a. Mục tiêu

- Máy in mạng

- Cách thức hoạt động

b. Tiến trình

Diễn giảng : tất cả các thiết của máy tính đều là tài nguyên riêng của nó, muốn mọi người sử dụng thì tiến hành chia sẻ nó

thể hiện thao tác chia sẻ cho học sinh xem

Yêu cầu học sinh vào máy của ban xem sự thay đổi 

Diễn giảng : khi máy in đưa vào mạng trở thành công cộng, muốn sử dụng chung thì phải khai báo với máy tính

thể hiện thao tác chia sẻ cho học sinh xem
	Lắng nghe, quan sát, ghi bài, lặp lại thao tác

Máy in xuất hiện trong nguồn tài nguyên của máy bạn

Lắng nghe, quan sát, ghi bài, lặp lại thao tác




IV. Tổng kết, đánh giá

- Hiểu rõ khái niệm chia sẻ

- Biết liệt kê các tài nguyên dùng chung trong mạng

- Thành thạo việc chia sẻ thư mục trong máy tính

- Có khả năng nhận biết và in trên máy in mạng

V. Dặn dò
Tiết PPCT: 100, 101, 103


                              
      Ngày soạn: ….../…../20.....

Tuần:
35







      Ngày dạy: ….../…../20......

BÀI 34: TÌM HIỂU NGHỀ
I. Mục tiêu

1. Kiến thức:
· Biết được vị trí nghề trong xã hội;

· Biết thông tin cơ bản về nghề Tin học văn phòng;

· Có ý thức tìm hiểu nghề và định hướng nghề cho tương lai.
2. Kỹ năng:
     - Biết cách tìm kiếm thông tin về nghề Tin học văn phòng.

3. Thái độ:
    - Ý thức học tập nghiêm túc, ham tìm hiểu để có định hướng đúng về việc chọn lựa nghề phù hợp cho bản thân.
II. Chuẩn bị
1. Giáo viên: SGK nghề, giáo án.
2. Học sinh: SGK nghề, vở ghi.
III. Tiến trình bài giảng
1. Ổn định lớp

2. Kiểm tra bài cũ

3. Nội dung bài mới

	NỘI DUNG
	HOẠT ĐỘNG CỦA GV
	HOẠT ĐỘNG CỦA HS

	I. SỰ CẦN THIẾT PHẢI TÌM HIỂU NGHỀ:

1. Sự cần thiết phải tìm hiểu thông tin nghề nghiệp:

- Chọn nghề là một quá trình lâu dài và đòi hỏi không ít nỗ lực của bản thân, gia đình và xã hội.
- Thông tin cần tìm hiểu:

· Thông tin về nghề;

· Thông tin về đào tạo nghề;

· Sự phù hợp của nghề;

· Xác định năng lực bản thân để hiểu được mức độ phù hợp nghề.


	Hoạt động 1: Tìm hiểu  nghề
a. Mục tiêu: Giúp cho học sinh thấy được việc tìm hiểu các lĩnh vực nghề trước khi đi đến quyết định chọn nghề là rất cần thiết.
b. Tiến hành:

- Dẫn đề: Nêu lý do cần tìm hiểu nghề.

- Giải thích bằng VD: “Muốn trở thành Bác sĩ phải mất 12 năm phổ thông + 4 năm đại học + 2 năm thực tập ở bệnh viện. Vượt qua hàng trăm kỳ thi, chi phí cho việc học, sách vở, quần áo, ăn ở, đi lại…không thể tính được.”

- GV cho HS thấy tính đa dạng, phong phú của thế giới nghề nghiệp. Ví dụ  tin học có các ngành tin học văn phòng, sửa chữa máy tính, thiết kế đồ họa, kỹ xảo truyền hình, quảng cáo, thiết kế website, kinh doanh phần mềm…


	- Biết lý do cần tìm hiểu nghề.

- Nhận thức được chọn nghề cho bản thân. Nắm được mỗi lĩnh vực ngành nghề đòi hỏi trình độ, chuyên môn nhất định.

- Nhận thức được tính đa dạng, phong phú của nghề nghiệp. 
- Trả lời trong SGK:

· Thông tin về nghề;

· Thông tin về đào tạo nghề;

· Sự phù hợp của nghề;

· Năng lực bản thân để hiểu biết được phù hợp nghề.



	II. ĐẶC ĐIỂM & YÊU CẦU CỦA NGHỀ:

1. Đối tượng và công cụ lao động của nghề:

a. Đối tượng:

( Các chương trình ứng dụng trong CTVP

( Các loại VB hành chính, bảng biểu, bảng tính trong công việc văn phòng.

( Tài nguyên trên mạng

b. Công cụ:

· Máy vi tính + Internet.

· Các thiết bị lưu trữ và lưu trữ dự phòng thông tin.

· Máy in, photocopy, điện thoại/fax


	Hoạt động 2: Tìm hiểu về đặc điểm, yêu cầu của nghề.

a. Mục tiêu: Giúp học sinh nắm bắt được đặc điểm, yêu cầu, triển vọng của nghề THVP.

b. Tiến hành:

Dẫn ý: Thế giới nghề nghiệp rất đa dạng, phong phú, có hàng vạn nghề với những chuyên môn khác nhau. Ngành nghề nào cũng có những đối tượng, đặc điểm, yêu cầu và sử dụng công cụ, phương tiện khác nhau.

Giả sử trong nghề dạy học thì đối tượng lao động chính là các học sinh; công cụ lao động là giáo án, sách vở, tài liệu tham khảo, đồ dùng dạy học, phấn…Hoặc nghề lái xe taxi có đối tượng lao động là hành khách;  công cụ lao động là chiếc xe taxi…Vậy nghề THVP có đối tượng lao động là gì?

Hỏi: Cô (thầy) văn phòng muốn làm việc hiệu quả thì cần những công cụ lao động hỗ trợ nào?

GV giới thiệu sơ lược chức năng của các công cụ VP.


	· Lắng nghe ví dụ gợi ý của GV và liên hệ đến đối tượng của nghề THVP.

- Xem SGK và trả lời:

· Các chương trình ứng dụng trong công tác VP như Windows, Word, Excel…

· Các văn bản, báo cáo…

· Tài nguyên trên mạng

Trả lời: Máy vi tính + internet, máy in, điện thoại/fax, photocopy.



	2. Nội dung lao động của nghề THVP:

- Soạn thảo, lưu trữ các văn bản hành chính hoặc văn bản nội bộ cơ quan.

- Lập bảng tính, thống kê, quản lý dữ liệu.

- Quản lý và lưu trữ các công văn đi, đến.

- Lập lịch công tác.


	Dẫn ý: Là một nhân viên mới, bạn tự hỏi: “Tôi phải  bắt đầu từ đâu? cần làm những công việc gì? Và làm như thế nào? 

Để trả lời được các câu hỏi này thì bạn đã xác định được nội dung lao động của nghề.

- Hỏi: Ở trường ta, các em thường thấy công việc của cô (thầy) văn phòng làm gì?


	Trả lời những hiểu biết của em khi liên hệ công việc với văn phòng: 

· Nhận, trả sổ đầu bài

· Đăng ký thi nghề

· Rút học bạ

· Xin giấy ra/vào lớp

· …

· Chia nhóm thảo luận và điền vào phiếu học tập.



	- Tạo, quản lý các bài trình chiếu và trình diễn chúng.

- Khai thác dữ liệu và tài nguyên trên mạng.

3. Điều kiện làm việc:

- Làm việc trong nhà, trang bị máy điều hoà nhiệt độ và hệ thống chiếu sáng đầy đủ.

- Công việc có ảnh hưởng đến thị lực, cột sống.

4. Yêu cầu của nghề:

- Tốt nghiệp THCS, Ngoại ngữ A, hiểu biết nhất định về văn bản quản lý nhà nước, có óc thẩm mỹ, sáng tạo.

- Sử dụng máy tính và các phần mềm ứng dụng văn phòng thành thạo.

- Làm việc cẩn thận, kiên trì, thận trọng và chính xác.

- Có sức khỏe trung bình, không bệnh tật.

5. Triển vọng của nghề:

- Nghề THVP luôn phát triển để phục vụ phát triển CNH, HĐH đất nước.

- Tương lai của nghề luôn gắn liền với mọi lĩnh vực KT-CT-XH.

- THVP có điều kiện phát triển ở thành thị lẫn nông thôn.


	- Gọi HS khác.

- Nhận xét và bổ sung ý kiến cho hoàn chỉnh.

- Làm việc theo nhóm, phát phiểu học tập và yêu cầu HS điền vào.

- Sau 3 phút, thu lại phiếu học tập, tổng hợp và phân tích.

- Nhắc nhở học sinh về an toàn lao động của nghề THVP có ảnh hưởng đến thị lực, cột sống do phải tiếp xúc thường xuyên với máy tính.

Dẫn ý: Trong bất kỳ lĩnh vực, ngành nghề nào cũng đòi hỏi người lao động phải có trình độ chuyên môn, kiến thức nhất định. Đối với nghề THVP thì phải đảm bảo những yêu cầu cơ bản nào?

· Nhận xét và góp ý thêm cho hoàn chỉnh.

· Nhấn mạnh thêm: Văn phòng là đầu mối giao tiếp của cơ quan nên người làm công tác văn phòng cần có khả năng ứng xử lịch sự, nhẹ nhàng và mềm dẻo, có thái độ thân thiện và đặt nhiệm vụ phục vụ lên hàng đầu.
Dẫn ý: Hiện nay, chính phủ đang rất nỗ lực cải cách thủ tục hành chính để giảm phiền hà cho nhân dân, mà hiệu quả nhất là ứng dụng công nghệ thông tin vào công tác văn phòng. Vì thế, mà nghề THVP có rất nhiều triển vọng, rất dễ tìm kiếm cơ hội việc làm.


	· Biết quý trọng sức khoẻ, làm việc khoa học và có thời gian thư giãn hợp lý.

· Trả lời: biết sử dụng vi tính; yêu nghề; sức khoẻ tốt…

· HS sẽ nhận thức được triển vọng phát triển của nghề trong tương lai; dễ dàng tìm kiếm được cơ hội việc làm vì phù hợp với xu hướng phát triển của xã hội hiện đại. 



	6. Những nơi đào tạo:

a. Một số địa chỉ đào tạo:

· Ngắn hạn:

· Trung tâm dạy nghề huyện.

· Trung tâm KTTH-HN

· Các cơ sở dạy nghề tư nhân.

· Các trung tâm dạy nghề xã hội.

· Dài hạn: cao đẳng, đại học.

b. Yêu cầu tuyển sinh:

· Ngắn hạn: TN THCS

· Dài hạn: TN THPT và đăng kí tuyển sinh đại học.


	- Giả sử thầy là một chuyên gia tư vấn hướng nghiệp, những thông tin mà các em muốn hỏi về nghề THVP là gì?

· Tư vấn và giới thiệu một số địa chỉ đào tạo nghề tin học văn phòng để sau này học sinh có thể liên hệ.

- Sau khi TN THPT, các em cần phải đăng ký thi tuyển sinh đại học ở các trường CNTT và tham gia học phần “Tin học VP”, sau khi học xong trường sẽ cấp giấy chứng nhận nghề cho các em. 

c. Tiểu kết:

· Chọn nghề phải tìm hiểu kỹ thông tin về đặc điểm, yêu cầu của nghề.

Chọn nghề phải chú ý đến triển vọng phát triển của nghề để dễ dàng có cơ hội tìm việc làm.
	· Hình thành ước mơ, hoài bão và phấn đấu học tập để biến ước mơ thành hiện thực.

Hỏi: “Muốn học nghề THVP thì đăng ký ở đâu? Hình thức học như thế nào? Học phí ra sao? Thời gian?..”

Học sinh sẽ có thông tin ban đầu về địa chỉ đào tạo, yêu cầu cơ bản hình thức đào tạo…để có định hướng cho sự quyết định lựa chọn nghề cho bản thân.


IV. Tổng kết, đánh giá

Sự thành công hay thất bại trong cuộc sống của bạn chính là sự quyết định đúng đắn, lựa chọn cho mình một nghề nghiệp phù hợp với bản thân, với năng lực thực sự và lòng yêu nghề; Trước khi đi đến quyết định chọn nghề bạn nhất thiết cần phải tìm hiểu thông tin cặn kẽ từ nhiều kênh thông tin như báo chí, internet, tư vấn tại các trung tâm,..Đặc biệt là người thân, cha mẹ đã từng trải qua những kinh nghiệm trong cuộc sống nên chắc chắn sẽ có những lời khuyên bổ ích cho bạn; Và bạn nên nhớ rằng, trong thành công của bạn luôn có 1% may mắn và 99% còn lại là nổ lực của bản thân.
V. Dặn dò
1. Để hiểu được một nghề cần chú ý đến những thông tin nào?

2. Em hãy cho biết nội dung chủ yếu của nghề phổ thông?

3. Nghề Tin học Văn phòng có triển vọng phát triển như thế nào?

4. Muốn trở thành nhân viên văn phòng, em cần trang bị cho mình những hành trang gì?

Tiết PPCT: 103
 



                              
      Ngày soạn: ….../…../20.....

Tuần: 36








      Ngày dạy: ….../…../20......

CÂU HỎI TRẮC NGHIỆM

NGHỀ TIN HỌC 

BÀI 2

1). Hãy thực hiện ghép các câu tương ứng sau cho đúng.

(Khi thực hiện vào 1 bảng chọn, và các nút chọn trên màn hình Windows)

	1. Nếu là dấu ( có nghĩa là
	a. Chỉ ra rằng khi chọn lệnh sẽ xuất hiện hộp thoại

	2. Biểu tượng   
[image: image9.png]


  Paste
	b. Tìm kiếm tệp/thư mục.

	3. Nếu là dấu .... có nghĩa là
	c. Thực hiện thao tác sao chép

	4. Biểu tượng  
[image: image10.png]


  coppy
	d. Khi chọn sẽ xuất hiện 1 bảng chọn tiếp theo.

	5. Dòng lệnh bị mờ
	e. Thực hiện thao tác cắt/xoá

	6. Biểu tượng  
[image: image11.png]


  cut
	f. Mục được chọn

	7. Nút  
[image: image12.png]Search



  Search
	g. Thực hiện thao tác dán

	8. Nếu là dấu  ( có nghĩa là
	h. Lệnh không được kích hoạt


2). Hệ điều hành là:

a. Phần mềm hệ thống.

b. phần mềm ứng dụng.

c. Phần mềm văn phòng.

d. Không thuộc loại nào trong các loại vừa nêu.

3). Để chọn 1 cửa sổ làm việc trong nhiều cửa sổ đang mở ta thực hiện:

a. Nháy chuột vào biểu tượng tương ứng trên thanh công việc.

b. Nháy chuột vào vị trá bất kỳ trên cửa sổ muốn kích hoạt.

c. Nhấn giữ Alt và nhấn phín Tab nhiều lần cho đến khi đến CTr ta cần.

d. Cả a, b, c đều đúng. 

4). Cùng 1 lúc có nhiều CTr được mở và có thể thao tác nhiều CTrình  ấy cùng 1 lúc.

a. đúng.

b. Sai.

BÀI 3

Câu 1. Thư mục gốc là thư mục

A. Chứa nhiều thư mục con nhất

B. Thư mục thấp nhất trong cây thư mục

C. Thư mục cao nhất trong cây thư mục
D. Luôn có tên C:\

Câu 2. Khi chọn một ĐT, ĐT đó sẽ

A. Đổi màu
B. Luôn luôn bị tô đen

C. Mở nội dung bên trong cho ta xem

D. Bị di chuyển lên trên cùng

Câu 3. Trong các chế độ xem sau, chế độ nào cho ta nhiều thông tin nhất về đối tượng

A. Icons

B. Titles

C. List

D. Details
Câu 4. Chuỗi lệnh File ( New ( Folder dùng để

A. Tạo thêm bản sao của thư mục đã có

B. Tạo thư mục mới hoàn toàn
C. Tạo thêm thư mục New có chứa thư mục Folder

D. Di chuyển thư mục Folder vào trong thư mục New

Câu 5. Muốn xóa đối tượng ta dùng

A. File ( Folder ( Delete

B. Edit ( Delete

C. File ( Delete
D. Edit ( Folder ( Delete

Câu 6. Khi kéo ĐT vào thư mục (bên trái) chứa chính nó. Windows sẽ

A. Chép đè đối tượng lên chính nó

B. Thông báo xác nhận chép đè

C. Thông báo lỗi
D. Tạo thêm bản sao có tên Copy of <Tên ĐT>

BÀI 4

1. Thao tác nào sau đây là để chọn đối tượng:


A. Nháy đúp chuột.


B. Nháy chuột.


C. Nháy chuột phải.


D. Cả 3 cách trên.

2. Khởi động một chương trình ứng dụng:


A. Nháy chuột trái vào đối tượng và chọn Open.  


B. Nháy đúp vào đối tượng muốn khởi động.


C. Nháy vào đối tượng muốn khởi động.


D. Nháy chuột phải vào đối tượng và chọn Open.

3. Cách khởi động nào sau đây không dùng để khởi động Word:


A. Start ( All Programs ( Microsoft Office ( Microsoft Office Word 2003.
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B. Start ( Control Panel( Microsoft Word.


C. Nháy vào biểu tượng           trên thanh trạng thái.
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     trên màn hình Desktop.

4. Để kết thúc một chương trình trong Windows ta chọn:


A. Edit ( Close

B. File ( Close
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  ở góc phải trên màn hình.

D. Edit (Exit.

5. Tìm một thư mục ta chọn:

A. Start ( Search

B. Start ( Setting

C. Start ( Programs

D. Start ( Document.

6. Để mở nhanh một tệp mới mở gần đây mà không cần nhớ địa chỉ ta thực hiện:


A. File ( Nháy vào một tên tệp.

B. File ( Open.


C. Start ( My Recent Documents ( Nháy vào một tên tệp.


D. Nháy vào biểu tượng My Computer ( chọn tệp muốn mở.

BÀI 5

1. Control panel là:

a. một tập hợp các chương trình

b. một tổ hợp phần mềm cơ bản

c. một công cụ dùng thực hiện trang bảng tính

2. Tác dụng của control panel là:

a. Dùng quản lý hệ thống phần mềm trong máy tính

b. Dùng thực hiện gõ văn bản

c. Dùng để cài đặt các tham số hệ thống

d. Dùng để điều chỉnh, sao chép, vẽ một số đối tượng

3. Thao tác: Start – Control panel dùng để:

a. Kết thúc Control panel

b. Khởi động Control panel

c. Chỉnh sửa các thông số trong Control panel

d. Thiết đặt màn hình nền

4. Để kết thúc Control panel ta thực thao tác sau:

a. File – Close

b. Close (x)

c. Alt + F4

d. Tất cả các thao tác trên

5. Cài đặt máy in ta thực hiện:

a. Start – Control Panel – Printers and Faxes

b. Start – Setting – Printers and Faxes

c. Start – Document – Printers and Faxes

d. Start – Program – Printers and Faxes

6. Thay đổi hình nền trên màn hình: Control – appearance and Themes – Display – Display Properties

a. Themes

b. Desktop

c. Screen Saver

d. Setting

BÀI 6

1. Để tạo thư mục ta thực hiện:

a. Kích chuột phải chọn new ___shortcut

b. Kích chuột phải chọn new ___folder   (
c. Kích chuột phải chọn new ___foller

d. Kích chuột phải chọn new ___shorcut

2. Để khởi động Windows Explorer ta thực hiện :

a. Kích chuột phải vào nút start chọn explorer

b. Kích chuột phải vào my computer. chọn explorer

c. Kích chuột phải vào My Computer chọn open

d. a , b thực hiện được   (
3. Để mở một tập tin một thư mục ta thực hiện:

a. Chọn đối tượng cần mở,kích chuột phải chọn Open

b. Chọn đối tượng cần mở, nhấn phím Enter

c. Kích đúp vào đối tượng cần mở 

d. Cả a, b , c đều đúng.   (
4. Để sao chép tập tin hay thư mục ta thực hiện:

a. Kích chuột phải chọn Cut

b. Kích chuột phải chọn Rename

 c.  Kích chuột phải chọn Copy    (
d . Kích chuột phải chọn New

5. Tìm kiếm thư mục hoặc tập tin ta thực hiện :

a. Start___Setting

b. Start___search      (
c. Start____Help and Support

d. Cả 3 câu đều sai

6. Đê thoát khỏi chương trình ứng dụng ta thực hiện:

a. File _____close

b. File_____exit

c. nháy chuột vào nút lệnh (X)

d. Alt + F4​  

e. cả 4 cách.       (
BÀI 7

1. Phím Enter có tác dụng:

a) Kết thúc một câu.

b) Kết thúc một dòng

c) Kết thúc một đoạn

2.Chọn câu đúng:

a) Mẫu câu :”Tôi yêu tin học”.

b) Mẫu câu : ”Tôi yêu tin học”

c) Mẫu câu :”Tôi yêu tin học.”

d) Mẫu câu: ”Tôi yêu tin học.”
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3. Ctrl+ Shift +
:có tác dụngchon từ vị trí con trỏ đến:

a) Cuối từ 

b) Cuối đoạn

c) Cuối dòng

4. để di chuyển một đoan văn bản từ 1 trang qua trang khác ta thực hiện:

a) Kéo và thả chuột

b) Sử dung Cut & Paste

c) Xóa và gõ lại

d) Tím kiêm và thay thề

5. để xem vă bản dưới dạng dàn bài ta xem ở chế độ:

a) Web Layout

b) Out line

c) Print Layout

d) Full Sreen

6. Để chọn toàn bộ văn bản ta nhấn tổ hợp phím:

a) Ctrl +A

b) Ctrl + C

c) Ctrl + V

d) Ctrl + B

BÀI 8

1.Để định dạng kí tự ta chọn hộp thoại 

a. Page Setup 

b. Paragraph 

c. Font 

d. Cả 3 cây đều sai

2. Tổ hợp phím Ctrl+I có tác dụng:

a. in nghiêng 

b. in đậm 

c. gạch dưới 

d. Canh đều

3. Để tăng kích cỡ (side) ta dùng tổ hợp phím :

a. Ctrl+]
 b. Ctrl+[ 

c. Ctrl+Shift +W

 d. Ctrl + P

4. Tổ hợp phím Ctrl+J có tác dụng :

a. Canh trái

 b. canh giữa 

c. canh đều

 d. canh phải

5. Muốn đổi chữ hoa sang chữ thường hoặc ngược lại ta thực hiện:

a. Shift +F3 
    b. Format __Change Case 
     c. Shift + F2          d. Cả a , b  đúng

6. Bôi đen nhanh toàn bộ văn bản ta thực hiện:

a. Ctrl+A 
b. Edit ___Clear 
    c. Edit____Select

d. Câu a , c đúng

BÀI 9

1. Lệnh nào sau đây dùng hiện thanh công cụ Tables and borders lên màn hình soạn thảo:

a. lệnh view, chọn Toolbars và chọn dòng Drawing…

b. lệnh view, chọn Toolbars và chọn dòng Tables and Borders
c. lệnh view, chọn Toolbars và chọn dòng Word Art

d. lệnh view, chọn Toolbars và chọn dòng Reviewing
2. Để gộp nhiều ô thành một ô, trước hết ta cần chọn số ô cần gộp rồi thực hiện:

a. Nhấp nút phải chuột, rồi chọn Merge Cells trên bảng chọn nhanh

b. Lệnh windows, chọn Merge cells…

c. Lệnh table, chọn Merge cells
d. Nhấp chuột lên biểu tượng Merge Cells trên thanh công cụ Tables and Borders
3. Để tạo bảng ta thực hiện:
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Lệnh Table       Insert     Table…
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Lệnh Insert      Table

c. Nháy chuột vào nút [image: image15.png]


   trên thanh công cụ

d. Nhấn tổ hợp phím Ctrl+T

4. Lệnh format borders and shading… dùng để

a. tạo đường viền và tô màu nền cho đoạn văn bản

b. định dạng bảng

c. tạo đường viền và tô màu nền cho bảng

d. tạo đường viền và tô màu nền cho kí tự

(chọn phương án sai)

5. Để sắp xếp dữ liệu trong bảng, ta thực hiện:

a. [image: image44.jpg]


Tools       Sort…

b. [image: image45.jpg]


Table      Sort…

c. nháy chuột vào nút [image: image16.png]


 hoặc nút [image: image17.png]


 trên thanh công cụ

d. b và c đều đúng

6. Hãy ghép mỗi chức năng ở cột bên trái với lệnh tương úng ở cột bên phải.
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1. Table       Merge       Cells
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2. Table       Insert
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3. Table       Insert      Table…
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4. Table       Delete
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5. Table        Formula…
f. Sắp xếp trong bảng



6. Table        Split Cells…

g. Tính tóan trong bảng



7. Table         Sort…
BÀI 10

1. Để mở bảng tab dùng thao tác nào sau đây:

a) Format(Tabs…

b) Insert(Tabs…

c) View(Tabs…

d) Tất cả đều sai…

2) Để định dạng văn bản vào giữa trang dùng nút lệnh sau đây:

a) 


b)


c)


d)

3) Để chuyển từ chữ in sang chữ thường và ngược lại dùng phím tắt nào:

a) Shift + F1.

b)Shift + F2

c) Shift + F3

d) Shift + Space bar

4) Để gộp nhiều ô thành một ô, sau khi chọn các ô ta dùng thao tác nào sau đây:

a) Format( Merge Cells

b) Table( Merge Cells

c) Table ( Cell( Merge Cells

d) Nhấp phải chuột( Cell( Merge Cells

5) Tách một ô thành nhiều ô sau khi chọn ô, ta dùng thao tác :

a) Format( Split Cells

b) Table( Split Cells…

c) Table ( Cell( Split Cells

d) Nhấp phải chuột( Cell( Split Cells

6)  Để các đường viền của Table chỉ hiển thị xem khi soạn thảo nhưng không được in ra ta dùng:

a) Format(Bullet and Numbering( chọn None

b)Table ( Draw Table (Eraser(xóa đường).

c) Format(Borders and Shading…(Borders( None

d) Tất cả đều sai
BÀI 11

1. Tạo danh sách liệt kê hoặc số thứ tự thao tác nhanh ta nháy chuột vào nút lệnh:
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b) 

c)

d)

2). Định dạng chi tiết các kí hiệu or số thứ tự khi đã chọn đoạn văn bản cần định dạng ta vào:

a)Format(Bullet

b)Format(Boder and Shading…

c)Format(Paragraph…

d)Format(Bullet and Numbering…

3) Tạo chữ cái lớn đầu đoạn văn sau khi chọn đoạn văn bản ta vào:

a)Format(Change case…

b)Format(Column..

c)Format(Drop Cap

d)Format(Font

4) Trong định dạng cột chế độ xem nào hiển thị được các cột:

a)Normal

b)Web Layout

c)Reading Layout

d)Print Layout

5) Định dạng cột cho đoạn văn ta dùng lệnh:

a)Format(Drop Cap

b)Format(Column

c)Format(Paragraph

d)Format(Change Case

6) Để định dạng 1 đọan văn bản giống với định dạng 1 đoạn văn bản khác ta dùng:


a) 

b)

c)

d)

7) Ta có thể định dạng tối đa 1 đoạn văn bản thành bao nhiêu cột 

a) 3

b) tối đa 45 nhưng còn tùy thuộc vào trang giấy

c) 2

d) 5

8) Có 1 đoạn văn bình thường nằm giữa hai danh sách liệt kê dạng số thứ tự. Muốn đánh số danh sách thứ hai tiếp theo danh sách thứ nhất cần thực hiện thao tác gì ?

a) Nháy vào nút

b) Dùng chức năng sao chép định dạng: Format Painter

c)Vào Format( Bullet and Numbering…

d)Tất cả đều sai.

9) Chức năng tạo chữ cái lớn đầu đoạn văn và chia cột có được dùng trong văn bản hành chánh chính không?

a) Có 

b) Không

BÀI 12

1. Câu nào sau đây thưc hiện lệnh ngắt trang:

a. Format-> Break->ok

b. Insert-> Break->ok

c. Insert-> Break->center.

d. Break-> Insert ->ok.

2. Câu nào sau đây thưc hiện lệnh chèn tiêu đề trang:

a. view-> Header and Footer 

b. Insert-> Header and Footer
c. Header and Footer ->Insert

d. Format-> Header and Footer
3. Câu nào sau đây thưc hiện lệnh Chèn hình ảnh
a. Picture  -> Clip Art -> Insert

b. Format-> Picture  -> Clip Art
c. Insert -> Picture  -> Clip Art

d. Clip Art-> Insert -> Picture  
4. Câu nào sau đây thưc hiện lệnh: Chèn các kí tự đặc biệt
a. Chọn Insert->Symbol
b. Chọn  view -> Symbol-> Insert

c. Chọn  Format -> Symbol-> Insert 

d. Chọn Insert->Symbol-> Insert 

BÀI 13

C©u 1: Gi¶ sö ta ®ang so¹n th¶o mét v¨n b¶n vµ muèn t×m kiÕm mét tõ hoÆc côm tõ th× ta thùc hiÖn :



A) LÖnh Edit/Replace…                       B) LÖnh Edit/Find…
                        C) LÖnh Edit/Goto…                            D) LÖnh Edit/Undo Typing

             H·y chän ph­¬ng ¸n ®óng.

             C©u 2: Trong khi so¹n th¶o v¨n b¶n, gi¶ sö ta cÇn thay thÕ ch÷ “Gi¸o viªn” thµnh ch÷ “ThÇy gi¸o” th×        ta thùc hiÖn:

                       A) Chän Edit/Find…                             B) Chän Edit/Replace…
                       C) Chän Edit/Goto…                             D) Chän Edit/Clear

              H·y chän ph­¬ng ¸n ®óng.

              C©u 3: §Ó söa lçi/gâ t¾t ta thùc hiÖn

A)LÖnh Tools, chän AutoCorrect Options… Vµ chän môc Replace text as you type ®Ó thiÕt ®Æt

B)LÖnh Tools, chän Costumize…
C)LÖnh Tools, chän Options…
D)LÖnh Edit, chän Replace…
              H·y chän ph­¬ng ¸n ®óng.

              C©u 4:Trong c¸c ph¸t biÓu d­íi ®©y, ph¸t biÓu nµo lµ sai?

A) NÕu tõ ®­îc gâ vµo « Find what lµ “SAPA” th× tÊt c¶ c¸c tõ sau n®Òu ®­îc t×m thÊy “Sa Pa”,”SAPA”, “sa pa”, “Sa pa”

B) Chøc n¨ng t×m kiÕm cho phÐp mét tõ hoÆc mét côm tõ

C)Chøc n¨ng thay thÕ cho phÐp thay mét tõ b»ng mét tõ hoÆc mét côm tõ víi ®iÒu kiÖn sè l­îng kÝ tù t×m vµ thay thÕ ph¶i b»ng nhau.

D)Chøc n¨ng thay thÕ cho phÐp xãa mét tõ hay mét côm tõ trong v¨n b¶n.

             H·y chän ph­¬ng ¸n ®óng.

             C©u 5: C¸c c«ng cô trî gióp so¹n th¶o, ®ã lµ:

                A) T×m kiÕm vµ thay thÕ                     B) Gâ t¾t vµ söa lçi

                C) C¶ A vµ B ®Òu ®óng     D) C¶ A vµ B ®Òu sai                         C©u 6: Theo h×nh minh häa, cho phÐp ng­êi sö dông

                A) Tõ viÕt t¾t “vt”, “td”, “Ms” sÏ thay thÕ cho côm tõ ®Çy ®ñ

             “vò trô”, “Tr¸I ®Êt”, “Microsoft”

                B) Xãa môc nµo ®ã b»ng c¸ch chän môc ®ã råi nhÊn nót Delete

                C) C¶ A) vµ B) ®Òu ®óng

                                         D) C¶ A) vµ B) ®Òu sai

            H·y chän ph­¬ng ¸n  ®óng nhÊt.                                                           

BÀI 14

1. Muốn tạo một kiểu mới trong văn bản hiện thời ta chọn:

    a. Format( Paragraph                                               b. Format ( Styles and Formatting
    c. Format ( Borders  and Shading                            c. Insert ( Borders  and Shading

2. Muốn tạo kiểu cho văn bản hiện thời một cách nhanh chóng ta thực hiện cách nào trong các cách sau:

    a. Nhấn tổ hợp phím Ctrl+F

    b. Nhấn tổ hợp phím Ctrl+H

    c. Nhấn tổ hợp phím Shift+ Q

    d. Nhấn tổ hợp phím Ctrl+Q 

3.Các kiểu sau đây kiểu ngầm định nào  là quan trọng.

a. Normal 

b. Bold

c. Bold+Italic

d.Footer

4. Hãy nêu các bước thực hiện khi sử dụng kiểu để định dạng:

    A. Nháy chuột mở hộp kiểu

    B. Chọn kiểu thích hợp.

    C. Đặt con trỏ vào đọan văn bản cần định dạng.

Hãy chọn thứ tự đúng:

a.  A, B, C


b. C, A B

c.  C, B, A


d. B, A, C

5. Để áp dụng kiểu kí tự cần phải 

a. Đưa dấu chèn vào một vị trí trên đoạn văn 

b. Đưa dấu chèn vào cuối đoạn văn

c. Chọn phần văn bản cần thiết

d. Chọn kiểu cần thiết trong hộp kiểu.

6. Phát biểu nào sau đây sai:

a. Kiểu là một tập hợp các đặc trưng định dạng được nhóm gộp dưới một tên kiểu 

b. Việc sửa đổi trình bày văn  bản sẽ nhanh chóng hơn nếu trước đó sử dụng kiểu.

c. Khi sử dụng kiểu chúng ta phải thao tác nhiều lần ở các nút lệnh định dạng 

d. Sử dụng kiểu văn bản sẽ được định dạng một cách nhất quán.

ĐÁP ÁN:

              1. c
2. d
3. a
4.b
5.c
6.c


BÀI 15

Câu  1. Để thiết đặt hướng giấy theo chiều ngang ta thực hiện:

a. Nhắp chọn mục Paper(Landscape(Ok

b. Nhắp chọn mục Layout(Portrait(Ok

c. Nhắp chọn mục Margins(Landscape(Ok

d. Nhắp chọn mục Margins( Portrait (Ok

Hãy chọn phương án đúng nhất

Câu 2: Để thiết đặt các thuộc tính định dạng trang ta thực hiện lệnh:

a. File(Print…

b. File( Print Preview

c.  File( Page Setup..

d. Cả 3 ý đều sai

Câu  3. Để thiết đặt hướng giấy theo chiều dọc ta thực hiện:

a. Nhắp chọn mục Paper( Portrait 

b. Nhắp chọn mục Layout(Portrait

c. Nhắp chọn mục Paper (Landscape

d. Nhắp chọn mục Margins( Portrait 

Hãy chọn phương án đúng nhất

Câu 4: Nếu ta muốn in tất cả các trang văn bản thì bạn chọn mục lệnh File(Print rồi chọn:

a. Chọn Curent page(Ok

b. Chọn Selection(Ok

c. Chọn Page rồi gõ số 3(Ok

d. Chọn All(Ok

Câu 5: Để xem văn bản trước khi in ta thực hiện

a. Lệnh View(Normal

b. Lệnh File( Print Preview

c.    File( Page Setup..

d.    Nhấp chuột lên biểu tượng Print Preview 
[image: image20.png]


  trên thanh công cụ.

Hãy chọn các phương án  đúng


Câu 6: Để in văn bản ta thực hiện lệnh:

a. File(Print…

b. File( Print Preview

c. Nhấn tổ hợp phím Ctrl+P

d. Nhấp chuột vào biểu tượng 
[image: image21.png]


 trên thanh công cụ

Hãy chọn phương án sai

BÀI 16

1.Biểu tượng nào thể hiện căn đều văn bản?


a)[image: image22.png]




b)[image: image23.png]




c)[image: image24.png]




d)[image: image25.png]



2. Tạo chữ in đậm, ta chọn biểu tượng nào?

a) B

b) I

c) U 

d) Ctrl + L

3. Muốn tạo chữ in nghiên ta ấn tổ hợp phím nào?.

a) Ctrl + B 

b) Ctrl + I

c) Ctrl + U 

d) Ctrl + L

4. Cách nào sau đây để tạo bảng?

a) Nháy chuột vào Table ( Insert ( table

b) Nháy chuột vào Table ( Picture.

c) Sử dụng nút lệnh Insert  table.

d) Câu a,c đúng.

5.Cách nào sau đây chèn ảnh có sẵn từ File ảnh.

a) Nháy chuột vào Insert ( Picture ( Word Art.

b) Nháy chuột vào Insert ( Picture ( Clip Art.

c) Nháy chuột vào Table ( Insert ( table

d) Nháy chuột vào Table ( Delete.

6. Cách nào sau đây lưu văn bản.

a) Nháy chuột vào File ( Save.

b) Nháy chuột vào biểu tượng Save trên thanh công cụ.

c)Ấn tổ hợp Ctrl+S.

d) tất cả đều đúng
BÀI 17

Câu 1: Chọn các thao tác đúng thực hiện mở bảng tính?

    a/ Start/ programs/ Microsoft office / microsoft office excel.

   b/ Nháy đúp vào biểu tượng ([image: image26.png]


) trên màn hình desktop.

    c/ Nháy  nút phải chuột vào biểu tượng ([image: image27.png]


) trên màn hình desktop.

    d/ Cả 3 đều đúng.

Câu 2: chọn đúng ưu điểm của bảng tính:

   a/ Khi có sai sót, muốn sửa đổi cần phải  lập lại bảng tính.

   b/ Khi thêm dữ liệu mới cần tính lại công thức.

   c/ khi muốn sắp xếp lại dữ liệu không cần phải lập lại bảng.

  d/ cả 3 đều sai.

Câu 3: Để thoát  khỏi excel ta sử dụng thao tác:

a/ File/ exit.

b/ Edit / close.

   c/ View/ exit.

   d/ cả 3 đều sai.

Câu 4: Để lưu bảng excel ta sử dụng thao tác:

a/ File/ save.

b/ Edit / save as.

          c/ file /save as.

   d/ cả 2 a,c đều đúng.

ĐÁP Án: câu1: d/;Câu2 :c/ ;   câu 3: a/ ; câu 4:d/

BÀI 18

1. Excel có thể lưu trữ và xử lí những kiểu dữ liệu nào
  
 A. Dữ liệu số

B.Dữ liệu kí tự

C.Dữ liệu thời gian
D. Cả 3 đều đúng

2.  Sau khi nhập dữ liệu, không thực hiện thao tác định dạng nào nếu nhìn vào trang tính ta có thể biết các ô chứa dữ liệu kiểu nào không?
 
A. Có


B. Không

3.  Chọn đồng thời hai cột tách rời trên trang tính cần nhấn giữ phím nào?
 
A. Phím Ctrl
B. Phím Alt
C. Phím Shift
   D. Phím Esc

4. Nhấn đồng thời hai phím CTRL+ HOME thực hiện việc nào dưới đây:

A.Trở về đầu hàng


B. Trở  về ô trên cùng, bên phải



C.Trở về cuối hàng


D. Trở về ô trên cùng, bên trái   

5. Trên trang tính chỉ có một ô được kích hoạt. Nếu ta chọn cả 3 ô: A1,B2,C3 thì ô nào được kích hoạt?

A. A1


B. B2


C. C3

D. Cả 3 đều đúng

BÀI 19

Câu 1: Điền các thao tác cần thực hiện khi nhập công thức vào ô tính trong bảng sau:

	Bước
	Thao tác

	1. 
	

	2.
	

	3.
	

	4.
	


Câu 2: Để biết được công thức trong ô tính ta chọn ô tính và quan sát công thức trên thanh công thức:

a. Đúng

b. Sai

Câu 3: Để nhập địa chỉ vào công thức, ta chỉ có duy nhất một cách là nhập trực tiếp từ bàn phím:


a. Đúng



b. Sai. Ta có thể nhập từ bàn phím hoặc nháy chuột vào ô, khối có địa chỉ cần nhập.

Câu 4: Chọn câu đúng nhất:

Nếu công thức có sử dụng địa chỉ ô thì khi thay đổi giá trị trong ô đó, kết quả trong ô tính sẽ:

a. Giữ nguyên giá trị

b. Bằng tổng giá trị cũ và giá trị mới

c. Tự động được cập nhật

d. Báo lỗi

Câu 5: Cho bảng tính sau:

	
	A
	B
	C
	D
	E

	1
	Ngày đến
	Ngày đi
	Số ngày ở
	Đơn giá/ ngày
	Thành tiền

	2
	10/9/2007
	15/9/2007
	
	120.000
	

	3
	12/9/2007
	13/9/2007
	
	60.000
	

	4
	18/9/2007
	20/9/2007
	
	240.000
	


Để tính số ngày ở, ta lập công thức ở ô C2 như thế nào:

a. =A2-B2

b. =B2 – A2

c. =Ngày đi – ngày đến

d. B2 – A2

Câu 6: Cũng với bảng trên. Hãy cho biết cách sắp xếp các thao tác để tính Thành tiền nào là đúng nhất:

1. Gõ dấu * rồi nháy chuột vào ô D2

2. Nhấn Enter

3. Gõ dấu =

4. Nháy chuột vào ô C2

5. Nháy chuột vào ô E2

a. 1-2-3-4-5

b. 4-3-5-1-2

c. 5-4-3-1-2

d. 5-3-4-1-2
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Câu 1: Nếu thay đổi vị trí các đối số( biến) trong các hàm SUM, MIN, MAX,AVERAGE thì kết quả có thay đổi không?

a. Thay đổi.

b. Không thay đổi.

Câu 2: Cho biết cú pháp nào đúng nhất khi sử dụng công thức hàm trong Exel:

a. =Tên hàm([ds các đối số]).

b. Tên hàm( [ ds các đối số]).

c. = Tên hàm().

d. Tất cả đều sai.

Câu 3: hãy cho biết cách dùng hàm nào đúng trong các cách sau:

a. =min(12,6,9)

b. =Min(3,20,6,9)

c. =MIN(15,3,6,9)

d. Tất cả a, b, c đều đúng 
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Câu 1: Muốn sửa dl trong một ô tính mà không cần nhập lại phải thực hiện thao tác gì?

a.Nháy ô tính và sửa dl.

b.Nháy chuột trên thanh công thức.

c.Nhấp phai trên ô tính và sửa dl

Câu 2: Địa chỉ tương đối là

a.Địa chỉ sẽ thay đổi khi sao chép.

b.Địa chỉ không thay đổi khi sao chép.

c.Địa chỉ dòng sẽ thay đổi khi sao chép

d.Địa chỉ cột sẽ thay đổi khi sao chép.

Câu 3: Trong các địa chỉ sao địa chỉ nào là địa chỉ tuyệt đối

a.$A1

b.$B$B

c.A$1

d.$A$1

Câu 4: Ô D1  có công thức =$A$1*B1 khi sao chép sang ô D2 thì công thức sẽ là:

a.A2+B2

b.A1+B1

c.$A$1+B2

d.$A1+B1

Câu 5: Khối C4:E10 có chứa DL. Cột F có công thức tính tổng các ô cùng hàng. Ta di chuyển khối C4:D10 sang trái 2 cột. Công thức trong cột F sẽ:

a.Vẫn chứa địa chỉ các ô ban đầu.

b.Được điều chỉnh tự động với địa chỉ các ô sau khi di chuyển.

c.Có thông báo lỗi #REF!
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1. Ô A1 có giá trị 10. kéo và thả nút điền xuống ô A4 sẽ nhận được dãy giá trị nào trong các ô A2,A3,A4

a. 10,11,12

b. 11,12,13

c. 10,10,10

2. Ô A1 có giá trị là “Excel”. Kéo và thả nút điền xuống ô A4 sẽ nhận được dãy giá trị nào trong các ô A2,A3,A4

a. Rỗng

b. Excel

c. Một giá trị khác

3. Ô A1 có giá trị 3, A2 có giá trị 7. chọn cả 2 ô và kéo thả nút điền xuống ô A6 sẽ nhận được dãy giá trị nào trong các ô A3,A4,A5,A6

a. 10,13,16,19

b. 3,7,10,13

c. 11,15,19,23

4. Ô A1 có giá trị 2, A2 có giá trị 4, A3 có giá trị 6. chọn cả 3 ô và kéo thả nút điền xuống ô A8 sẽ nhận được dãy giá trị nào trong các ô A4,A5,A6,A7 và A8 trong các dãy sau đây?

a. 2,4,6,2,4

b. 2,4,6,8,10

c. 8,10,12,14,16

5. Ta biết chắc rằng trên trang tính rất nhiều ô có cụm từ “Trường phổ thông”, nhưng khi sử dụng tính năng tìm ta không tìm thấy cụm từ đó. Hãy cho biết những lý do có thể

a. Đánh sai nội dung cần tìm trong Find what

b. Chọn Match case

c. Trong Lookin: chọn comments

d. Đánh sai nội dung cần tìm hoặc chọn Match case hoặc chọn coments
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Câu 1: Trong các phát biểu sau đây, phát biểu nào đúng:

A. Mục đích sử dụng đường biên và màu nền của các ô trên trang tính là để trang trí bảng tính tăng tính thẩm mỹ cho bảng tính. Chúng có ảnh hưởng đến dữ liệu của trang tính.

B. Mục đích sử dụng đường biên và màu nền của các ô tren trang tính là để trang trí, tăng tính thẩm mỹ cho bảng tính. Chúng không có ảnh hưởng đến dữ liệu của trang tính.

C. Mục đích sử dụng đường biên và màu nền của các ô trên trang tính là để trang trí cho bảng tính.

Câu 2: Hãy chọn những phát biểu đúng và đầy đủ trong các phát biểu sau:

A. Để kẻ đường biên cho ô hoặc khối ô ta thực hiện: 
B1: Chọn khối ô cần thao tác

B2: Chọn lệnh Format/Cells, chọn trang Border, chọn các thao tác theo yêu cầu hoặc nháy vào nút lệnh Border [image: image28.png]24 TN 24. doc - Microsoft Word CEEX)
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B. Để tô nền cho ô hoặc khối ô ta thực hiện: 
B1: Chọn khối ô cần thao tác

B2: Chọn lệnh Format/Cells, chọn trang Pattern, chọn các thao tác theo yêu cầu hoặc nháy vào nút lệnh Fill Color [image: image29.png]B3 Microsoft Excel - Book1
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C. Để kẻ đường biên cho ô hoặc khối ô ta thực hiện: 

Chọn lệnh Format/Cells, chọn trang Border, chọn các thao tác theo yêu cầu hoặc nháy vào nút lệnh Border [image: image30.png]24 TN 24. doc - Microsoft Word CEEX)
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D. Để tô nền cho ô hoặc khối ô ta thực hiện: 
B1: Chọn khối ô cần thao tác

B2: Chọn lệnh Format/Cells, chọn trang Pattern, chọn các thao tác theo yêu cầu 

Câu 3: Để thực hiện gộp ô và tách ô, ta sử dụng lệnh nào:

A. Chọn lệnh Format/Cells chọn trang Alignment đánh dấu ô    (    Merge cells rồi nháy OK

B. Chọn lệnh Format/Cells chọn trang Alignment đánh dấu ô    (    Merge cells (gộp ô) hoặc không đánh dấu ô      Merge cells (không gộp ô) rồi nháy OK

C. B1: Chọn khối ô

B2: Chọn lệnh Format/Cells chọn trang Alignment đánh dấu ô   (    Merge cells rồi nháy OK

D. B1: Chọn khối ô

B2: Chọn lệnh Format/Cells chọn trang Alignment đánh dấu ô   (    Merge cells hoặc không đánh dấu ô      Merge cells (không gộp ô) rồi nháy OK

Câu 4: Giả sử các ô A4 và A6 có dữ liệu tương ứng là 4 và 15. Ô E6 chứa công thức =A6+5. Sau đó ô A4, A5, A6 gộp lại. Công thức trong ô E6 sẽ cho kết quả như thế nào?

A. 4;

B. 15 (giá trị ban đầu của ô A6);

C. Cảnh báo và cho kết quả là 5;

D. Thông báo lỗi;

Câu 5: Phát biểu nào sau đây không đúng:

A. Sao chép định dạng là sao chép cả nội dung và định dạng của dữ liệu;

B. Sao chép định dạng là sao chép nội dung dữ liệu

C. Sao chép định dạng là sao chép phần định dạng của dữ liệu;
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 để sao chép định dạng; 

Câu 6: Giả sử ô A1 có màu nền xanh, dữ liệu màu đỏ. Nếu Copy ô A1 sang ô D35 thì ô D35 có:

A. Màu nền xanh, dữ liêụ màu xanh

B. Màu nền xanh, dữ liêụ màu đỏ

C. Màu nền đỏ, dữ liêụ màu xanh

D. Màu nền đỏ, dữ liêụ màu đỏ
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Câu 1: Hãy nêu ý nghĩa và mục đích của việc phân tích yêu cầu xây dựng trang tính:

D. Lập trang tính phù hợp để lưu trữ các thông tin cần xử lý; 

E. Lập trang tính phù hợp để thực hiện việc xử lý thông tin nhanh và chính xác;

F. Lập trang tính phù hợp sẽ giúp tiết kiệm thời gian và tránh các lỗi tính toán;

G. Nhập và trình bày dữ liệu theo các hàng, cột, bảng, hợp lý và thuận tiện cho việc điền nhanh các công thức

Câu 2: Cho các câu hỏi gợi ý sau:

1. Chúng ta cần tính toán gì? (Tính toán)

2. Bố trí dữ liệu như thế nào để tính toán nhanh và dễ dàng nhập dữ liệu mới (Trình bày trang tính)

3. Dữ liệu cần tính toán là gì? (Dữ liệu)

4. Mục đích lập trang tính là gì? (Mục tiêu)

Hãy sắp sếp các câu hỏi đúng trình tự để lập trang tính:

A. 4-3-1-2



B. 1-2-3-4



C. 3-2-1-4



D. 4-2-2-1

Câu 3: Khi phân tích yêu cầu lập trang tính, người sử dụng cần ghi lại những kết quả phân tích hay không?

E. Chỉ ghi những ý chính

F. Không ghi

G. Ghi đầy đủ phần phân tích theo trình tự lập và xử lý trang tính

H. Ghi theo ý của người sử dụn

Câu 4: Khi phân tích bài toán để lập trang tính, ta chỉ cần quan tâm đến:

E. Mục tiêu và dữ liệu

F. Tính toán và trình bày trang tính

G. Công thức tính toán

H. Cả A và B

Câu 5: Trong trang tính hình bên, cột dữ liệu

nhập vào nào thường xuyên thay đổi

E. Cột giá bán

F. Cột số lượng

G. Cột thành tiền

H. Cả A và B
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Câu 1: Cú pháp của hàm IF như sau: (ĐA:b)

a.IF(phép_so_sánh,giá_trị_khi_sai, giá_trị_khi_đúng).

b.IF(phép_so_sánh,giá_trị_khi_đúng, giá_trị_khi_sai).

c.IF(giá_trị_khi_đúng, giá_trị_khi_sai,phép_so_sánh).

d.IF(giá_trị_khi_đúng,phép_so_sánh, giá_trị_khi_sai).

Câu 2: Cú pháp IF(Phép_so_sánh,B,C) có ý nghĩa là: (ĐA:a)

a.Khi phép_so_sánh có giá trị đúng thì kết quả của hàm IF trả về là B,ngược lại là C.

b.Khi phép_so_sánh có giá trị đúng thì kết quả của hàm IF trả về là C,ngược lại là B.

c.Khi phép_so_sánh có giá trị sai thì kết quả của hàm IF trả về là C,ngược lại là B.

d.câu a và b đúng.

Câu 3:Công thức trong ô B1: IF(A1=”G”,”Giỏi”,IF(A1=”K”,”Khá”,”T_Bình”))có ý nghĩa là: (ĐA:d)

a.Nếu ô A1 bằng G thì ô B1 là giỏi và ngược lại thì ô B1 là T_Bình.

b.Nếu ô A1 bằng G thì ô B1 là giỏi và ngược lại thì ô B1 là Khá.

c.Nếu ô A1 bằng G thì ô B1 là giỏi và ngược lại nếu ô A1 bằng K thì ô B1 là T_Bình.

d.Tất cả đều sai.

Câu 4: Chọn cú pháp đúng nhất trong ô C1: (ĐA:a)

a.IF(A1=”A”,IF(B1=”Lần 1”,”Giỏi”,”Thường”),”Thường”).

b.IF(A1=”A”,IF(B1=”Lần 1”,”Giỏi”,”Thường”)).

c.Cả a và b đều sai.

d.Cả a và b đều đúng.

Câu 5: Cú pháp của hàm SUMIF như sau: (ĐA:d)

a.SUMIF(cột_so_sánh,cột_lấy_tổng, tiêu_chuẩn).

b.SUMIF(tiêu_chuẩn,cột_so_sánh,cột_lấy_tổng).

c.SUMIF(tiêu_chuẩn,cột_lấy_tổng,cột_so_sánh).

d.SUMIF(cột_so_sánh,tiêu_chuẩn,cột_lấy_tổng).

Câu 6: Công thức đúng trong ô C1 là: (ĐA:b)

a.SUMIF(A1:A7,’=2’,B1:B7).

b.SUMIF(A1:A7,”=2”,B1:B7).

c.SUMIF(A1::A7,”=2”,B1:B7).

d.SUMIF(A1:A7,”=2”,B1::B7).
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1) Để tính tổng các số trong cột A, tổng các số trong cột B, trung bình cộng các số trong cột A và cột B một học sinh đã áp dụng các cách sau. Em hãy chỉ ra cách làm sai:

a. Nháy chuột vào nút lệnh Insert Funtion   fx , nháy đúp chuột vào hàm SUM, trong Number1 gõ: A2, trong Number2 gõ: A3, trong Number3 gõ: A4, nháy nút OK.

b. Gõ hàm: =SUM(B2:B4) 

c. Nháy chuột vào nút lệnh Insert Funtion  fx , nháy  chọn hàm AVERAGE, nháy nút OK, trong Number1 gõ: B2:B4, nháy nút OK.

d. Gõ hàm: =AVERAGE(B2,B3,B4)/3
2) Để tính giá trị tuyệt đối |A-B| trong ô C2, một học sinh đã áp dụng các cách sau. Em hãy chỉ ra cách làm đúng:

a. Gõ công thức: =|A2-B2|

b. Gõ công thức: =A2-B2

c. Nháy chuột vào nút lệnh Insert Funtion  fx , nháy  chọn hàm MIN, nháy nút OK, trong Number1 gõ: A2:B2, nháy nút OK.

d. Gõ hàm: =IF(A2>B2,A2-B2,B2-A2)
3) Để thực hiện bài tập dưới đây, một học sinh thực hiện các thao tác sau. Em hãy chỉ ra cách làm cho kết quả đúng:

a. Để tạo ra các ô có cỡ chữ, màu chữ, đường viền và màu nền khác biệt: Đầu tiên chọn tất cả các ô, sau đó trong hộp thoại Format Cells lần lượt sử dụng các trang: Font để chọn cỡ chữ và màu chữ khác nhau, Border để chọn đường viền khác nhau, Patterns để chọn màu nền khác nhau.

b. Để hiển thị ngày hệ thống, trong ô D2 gõ: Ngày=TODAY()

c. Để tính Thành tiền, trong ô E4 gõ hàm: =SUM(C4*D4)

d. Để tính thuế, trong ô E8 gõ công thức: =10%*Tổng giá trị

4) Để thực hiện bài tập dưới đây, một học sinh thực hiện các thao tác sau. Em hãy chỉ ra cách làm cho kết quả đúng:

a. Để tính Tổng giá trị, trong ô E7 gõ hàm: =SUM(E3:E6)

b. Để hiển thị thêm số lẻ thập phân, nháy nút [image: image32.png]



c. Để tính Thành tiền, trong ô E5 gõ công thức: =C4*D4

d. Để tính thuế, trong ô E8 gõ công thức: =10%*MIN(E7)

5) Để thực hiện bài tập dưới đây, một học sinh thực hiện các thao tác sau. Em hãy chỉ ra cách làm chưa đúng:

a. Để hiển thị ngày hệ thống, trong ô C1 gõ: =TODAY(DAY)

b. Kẻ đường biên cho ô B1 và C1, tô màu nền đổi màu chữ cho ô C1

c. Chọn vùng C5:B7 nháy nút [image: image33.png]


 để hiển thị dấu phân cách hàng nghìn và nháy nút [image: image34.png]


 để bớt số lẻ thập phân.

d. Trong ô C10 gõ hàm: =SUMIF($B$5:$B$7,B10,$C$5:$C$7) 

Sau đó kéo thả Nút điền cho ô C11

6) Để thực hiện bài tập dưới đây, một học sinh thực hiện các thao tác sau. Em hãy chỉ ra cách làm chưa đúng:

a. Để hiển thị ngày hệ thống, trong ô C1 gõ: =TODAY()

b. Kẻ đường biên cho ô B1 và C1, tô màu nền đổi màu chữ cho ô C1

c. Chọn vùng C5:B7 nháy nút [image: image35.png]


 để hiển thị dấu phân cách hàng nghìn và nháy nút [image: image36.png]


 để bớt số lẻ thập phân.

d. Trong ô C10 gõ hàm: =SUMIF(B5:B7,B10,C5:C7) 

Sau đó kéo thả nút điền cho ô C11

BÀI 28

1. Ý nghiã của lệnh Data/sort:

a. Định dạng dữ liệu

b. Sắp xếp dữ liệu

c. Lưu dữ liệu

d. Tô nền

2. Ta có cách sắp xếp sau:

[image: image37.png]@ fscending
O pescending

© hsgending
O Descending
Then by

@ scendng
O Descanding

My deta range has
@Headerrow O No header row





Ý nghiã của cách sắp xếp trên là:

a. Sắp  xếp danh sách tăng dần theo tên. Nếu trùng tên thì sắp xếp theo họ

b. Sắp xếp danh sách tăng dần theo tên

c. Sắp  xếp danh sách giảm dần theo tên. Nếu trùng tên thì sắp xếp theo họ

d. Tất cả đều sai.

3. Cho bảng tính sau:


Để sắp xếp danh sách trên giảm dần theo điểm trung bình. Câu nào sau đây đúng?

a. Chọn Khối A2:F6, Chọn Data/sort/sort by: Trung Bình/Descending/OK

b. Chọn Khối A3:F6, Chọn Data/sort/sort by: Trung Bình/Descending/OK

c. Chọn Khối A2:F6, Chọn Data/sort/sort by: Trung Bình/Ascending/OK

d. Các câu trên đều sai

3.  Cho Bảng Tính sau:
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Để sắp xếp các kí tự  trên cột A theo thứ tự: A, B, C, D, Đ, E, F. Ta thực hiện:

a. Tool/option/Custom Lists/NewList: A, B, C, D, Đ,E,F../Chọn khối A2:A8/ Data/sort/tại sort by: chọn Column A/option/tại Fisrt key sort order: chọn A, B, C, D, Đ, E, F /OK/OK

b. Chọn khối A2:A8/Data/sort/Column A

c. Chọn Khối A2:A8/Data/sort/Column A/descending

d. Tất cả đều sai

BÀI 29

	Câu 1. Chọn và hiển thị các hàng thỏa mãn các tiêu chuẩn nào đó từ một danh sách là:

	A. Sắp xếp dữ liệu
	B. Kết xuất dữ liệu

	C. Xóa dữ liệu
	D. Tạo danh sách dữ liệu từ một danh sách khác

	Câu 2. Kết quả lọc dữ liệu

	A. Xóa dữ liệu
	B. Chỉ hiển thị các hàng thỏa mãn điều kiện

	C. Dữ liệu bị thay đổi
	D. Dữ liệu được sắp xếp lại

	Câu 3. Hộp thoại Custom AutoFilter dùng để

	A. Sắp xếp danh sách
	B. Tạo danh sách từ danh sách đã có

	C. Lọc danh sách tự động
	D. Tạo các tiêu chuẩn phức hợp

	Câu 4. Tùy chọn (Top 10…) không sử dụng với các cột dữ liệu là

	A. Văn bản
	B. Số

	C. Kí tự
	D. Thời gian

	Câu 5. Để thoát khỏi chế độ kết xuất dữ liệu ta thực hiện lệnh

	A. Data → Filter và bỏ đánh dấu AutoFilter
	B. Data → Filter và đánh dấu AutoFilter

	C. Data → Filter → Show all
	D. Data → Filter → Advanced Filter

	Câu 6. Để tạo ra các tiêu chuẩn phức hợp ta sử dụng lệnh

	A. Data→Filter→AutoFilter và chọn (Custom…)
	B. Data→Filter→AutoFilter và chọn (Top 10…)

	C. Data→Filter→ Advanced Filter 
	D. Data→Filter→AutoFilter 


BÀI 32, 33, 34


Câu 1: Phát biểu nào sau đây sai:



a.Mạng có dây kết nối các máy tính bằng cáp



b.Mạng không dây kết nối các máy tính bằng sóng Radio, bức xạ hồng ngoại, 




sóng truyền qua vệ tinh



c.Mạng không dây không chỉ kết nối các máy tính mà còn cho phép kết nối các 




điện thoại di động.



d.Mạng có dây có thể đặc cáp đến bất cứ địa điểm và không gian nào.


Câu 2: Tìm phát biểu sai về mạng kết nối kiểu vòng nêu dưới đây:



a.Các máy tính được nối trên một vòng cáp khép kín (không có đầu hở)



b.Phương tiện kết nối đơn giản và dễ lắp đặc



c.Mọi máy tính đều có nguồn truy cập mạng như nhau



d.Dữ liệu truyền trên cáp theo hai chiều nhận và gửi ngược nhau.


Câu 3: Phát biểu nào dưới đây sai khi nói về mạng kết nối kiểu đường thẳng:



a.Tất cả các máy tính kết nối vào một cáp trục do đó tiết kiệm cáp.



b.Kết nối tương đối đơn giản



c.Số máy tính trong mạng không ảnh hưởng đến tốc độ truyền dữ liệu


Câu 4: Tìm phát biểu sai về mạng kết nối kiểu hình sao nêu dưới đây:



a.Cần ít cáp hơn các mạng kết nối kiểu đường thẳng và kiểu vòng.



b.Dễ mở rộng mạng (thêm máy tính)



c.Các máy tính được nối cáp vào một thiết bị trung tâm hub



d.Nếu hub bị hỏng thì toàn bộ mạng nhừng truyền thông


Câu 5: Phát biểu nào dưới đây sai:



a.Môi trường truyền thông của mạng không dây là sóng Radio, bức xạ hồng 




ngoại hoặc sóng truyền qua vệ tinh.



b.Mạng không dây dễ dàng mở rộng, ít bị hạn chế về không gian và vị trí kết 




nối. Mạng không dây dễ lắp đặc và có thể triển khai trên nhiều loại địa hình 




khác nhau.



c.Vùng phủ sóng của một mạng không dây là không hạn chế.


Câu 6: Phát biểu nào dưới đây sai:



a.Mọi chức năng của điểm truy cập không dây (WAP) đều được tích hợp trong 




bộ định tuyến không dây.



b.WAP dùng để kết nối các máy tính trong mạng không dây 



c.WAP không cho phép kết nối mạng không dây vào mạng có dây


Câu 7: Hãy xác định những câu nào dưới đây mô tả mạng cục bộ (LAN)



a.3 máy tính và 1 máy in kết nối với nhau, có thể dùng chung máy in.



b.Một máy tính ở Hà Nội và một máy tính ở Quảng Trị có thể trao đổi và sử 



dụng chung các tài liệu



c.150 máy tính hoạt động độc lập trên tầng 4 của Trung Tâm Dạy Nghề Hai Bà 




Trưng



d.200 máy tính ở các tầng 2, 3, 4 của một toà nhà cao tầng được nối cáp với 




nhau để dùng chung dữ liệu, máy in và các tài nguyên khác


Câu 8: Tìm phát biểu sai về các dịch vụ được hổ trợ bởi mạng LAN trong các phát 




biểu nêu dưới đây:



a.Dùng chung dữ liệu và truyền tệp



b.Dùng chung các ứng dụng và các thiết bị ngoại vi (máy in, máy quét,  máy 




Fax, modem …)



c.Cho phép gửi và nhận thư điện tử trên toàn cầu.


Câu 9: Chọn từ (cụm từ) thích hợp trong số các từ (cụm từ): máy khách, máy chủ, 




người quản trị mạng, sự bảo mật và an toàn; để điền vào chỗ trống (…) trong 




các câu sau:



a.Trong mạng ngang hàng, mỗi máy tính có thể có cả hai vai trò: máy chủ và … 



b.Mạng ngang hàng thường được chọn sử dụng khi … không đặt thành vấn đề 




quan trọng.



c.Trong mạng ngang hàng mỗi người tự quản lý máy của mình, không quản lý 




toàn mạng nên không thể coi là …



d.Trong mạng ngang hàng không tồn tại các … chuyên dụng


ĐA: a: máy khách; b: Sự bảo mật và an toàn; c: Người quản trị mạng; d: máy chủ


Câu 10: Chọn từ (cụm từ) thích hợp trong số các từ (cụm từ): tài nguyên chung, máy 




chủ, máy khách; để điền vào chỗ trống (…) trong các câu sau:



a….Cung cấp tài nguyên chung cho người dùng mạng



b….truy cập tài nguyên dùng chung trên mạng do … cung cấp



c.Máy khách chạy các trình ứng dụng và có thể yêu cầu … cung cấp…


ĐA: a: Máy chủ; b: máy khách, máy chủ; c: máy chủ, tài nguyên chung.


Câu 11: Để xem các tài nguyên trên mạng (trong Window XP) ta sử dụng:



a.Biểu tượng        (My Network Places-mạng của tôi).



b.Nháy chuột vào biểu tượng



c.Nháy chuột phải vào Start/Explore



d.Tất cả đều đúng.

Câu 12: Mô hình mạng ngang hàng là:



a.Ít nhất có một máy có vai trò đặc biệt (gọi là máy chủ).



b.Được cài đặt hệ điều hành quản lí theo vùng.



c.Tất cả các máy tính trên mạng đều bình đẳng với nhau.



d.Người sử dụng máy trạm có thể chia sẻ tài nguyên.


Câu 13: Công cụ nào dưới đây đặc trưng cho nền văn minh thông tin:



a.Máy thu hình.



b.Điện thoại di động



c.Máy tính điện tử



d.Mạng Internet


Câu 14: Phát biểu nào dưới đây là chính xác nhất:



a.Tin học là môn học sử dụng máy tính điện tử.



b.Tin học là môn học nghiên cứu, phát triển máy tính điện tử.



c.Tin học có mục tiêu là phát triển và sử dụng máy tính điện tử.



d.Tin học có ứng dụng trong mọi linh vực hoạt động cuả con người.


Câu 15: Tin học là một ngành khoa học vì đó là ngành



a.Chế tạo máy tính



b.Nghiên cứu phương pháp lưu trữ và sử lí thông tin



c.Sử dụng máy tính trong mọi lĩnh vực hoạt động của xã hội loài người



d.Có nội dung, mục tiêu, phương pháp nghiên cứu độc lập.



Hãy chọn phương án ghép đúng


Câu 16: Phát biểu nào dưới đây là sai.



a.Giá thành của máy tính ngày càng hạ, nhưng tốc độ, độ chính xác của máy 




tính ngày càng cao



b.Các chương trình trên máy tính ngày càng đáp ứng được nhiều ứng dụng thực 




tế và dễ sử dụng hơn



c.Máy tính ra đời làm thay đổi phương thức quản lý và giao tiếp trong xã hội



d.Máy tính tốt là máy tính nhỏ, gọn và đẹp


Câu 17: Các việc nào dưới đây cần phê phán?



a.Sao chép phần mềm không có bản quyền



b.Đặt mật khẩu cho máy tính của mình.



c.Sử dụng mã nguồn chương trình của người khác đưa vào chương trình của 




mình mà không xin phép.



d.Phát tán các hình ảnh đồ trụy lên mạng.


Câu 18: Việc nào dưới đây không bị phê phán:



a.Tự ý thay đổi cấu hình máy tính không được sự cho phép của người phụ trách 




phòng máy. Tự ý đặt mật khẩu cá nhân trên máy tính dùng chung



b.Cố ý làm nhiểm virus vào máy tính trong phòng máy của trường



c.Quá ham mê các trò chơi điện tử



d.Tham gia một lớp học trên mạng về ngoại ngữ.

Tiết PPCT: 104, 105
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